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WARNING

To ensure the equipment described by this User Manual, as well as the equipment connected to
and used with it, operates satisfactorily and safely, all applicable local and national codes that
apply to installing and operating the equipment must be followed. This includes the National
Electric Code in the USA and other applicable legislation, regulations, and codes in practice
elsewhere. Since codes can vary geographically and can change with time, it is the user’'s
responsibility to determine which standards and codes apply, and to comply with them.

FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL.

Persons supervising and performing installation or maintenance must be suitably qualified and
competent in these duties, and should carefully study this User Manual and any other manuals
referred to by it prior to installation and/or operation of the equipment.

The contents of the User Manual are believed to be correct at the time of printing; however, no
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of
continuous development and improvement, the manufacturer reserves the right to change the
specification of the product or it's performance or the contents of the User Manual without notice.

Copyright © 2004 - 2007 Systems Engineering Associates, Inc.

All Rights Reserved!
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SECTION 1
GENERAL DESCRIPTION

The S3016-505 is aversion of the S3016 CO-CPU communications
board that resides on the Texas I nstruments 505 bus structure. With
the exception of that difference, the S3016-505 provides al the same
features as the standard S3016. The S3016-505 is a communications
CO-CPU board, which provides one S3000 serial network interface
port and one RS-232/RS-422 USER PORT. The S3016-505 isatrue
CO-CPU with it's own processor and program/data memory which
executes a user application program independent of the Tl 505 main
processor. The primary use of the S3016-505 isto allow
communications between the T1 505 family of processors and the
S3000/M4000 line of processors viathe S3000 serial network. The
S3016-505 can beinstalled in any 1/0 dlot of the Tl 505 rack. In
addition, any number of S3016-505s may be installed in one T1 505
rack (up to the number of 1/O dlots available). This manual describes
the features unique to the S3016-505, refer to the S3016 User's
Manual for details on the S3016 in general.

1.1 FEATURES

Communications CO-CPU Board with S3000 Serial Network
Interface and RS-232/RS-422 USER PORT.

Built in Processor executes User application program
independently of main T1 505 processor.

Resides on T1 505 Bus structure as a3 word in/ 5 word out
Specia Function module (smilar to a Tl Peerlink module).

Provided with “MCOM505” S3016-505 program and
“NETCOM” (DOS and Windows based) setup program which
allows the T1 505 processor to communicate with up to 31
S3000/M 4000/S3016-505 slave nodes with up to 120 words to
and from each slave node.

24K Bytes User Program memory.

2K Bytes Data memory.

Built in Real Time clock provides current time and date.
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SECTION 1

GENERAL DESCRIPTION

Fast program execution time (0.6 Milliseconds per 1K Bytes
Program memory).

Programmed with “SY Sdev” program devel opment software
package. This allows the S3016-505 to be programmed in a
combination of Ladder, High-level ('C’) and Assembly (MCS-51).

Interfaces with PC or Laptop computer via RS-232 for program
download and on-line monitoring.

Extensive internal diagnostics/fault detection including watchdog
timer, communications fault detection, hardware confidence test,
etc.

Status LEDS on faceplate (RUN, SERIAL NETWORK COMM,
and FAULT)

Standard single width Tl 505 module size.

1.2 S3000 SERIAL NETWORK OPERATION

The S3000 seria network provides a means for the S3016-505 to
communicate with other S3000/M4000/S3016-505 processors
(nodes). The network operates in a master/slave topology. The S3016-
505 is the master and controls all communications on the network.
The remaining S3000/M4000/S3016-505 nodes act as slaves and
simply respond to communications requests from the master. The
master can send up to 120 consecutive words and receive up to 120
consecutive words from the slave in one command.

Up to 31 slave nodes can be connected to one S3016-505. Each node
on the network is assigned a unique address from 1 to 32. The S3016-
505 master node is automatically set to 1 when the “MCOM505”
program is used, while the slave nodes are assigned addresses 2
through 32. The network address is used to specify which slave the
master is communicating to. The network addressesin the

S3000/M 4000 nodes are set from the SY Sdev Target Board Interface
Menu and downloaded directly to the node from the PC or Laptop
computer running SY Sdev.
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SECTION 1
GENERAL DESCRIPTION

Communications from the master isimplemented using System
function 13 (sfuncl13). See the S3016 User's Manual for details on the
system function 13 or the “MCOMS505” program printout in appendix
A for an example of using sfuncl3.

1.3 COMMUNICATIONS BETWEEN T1505 AND S3016-505

Communications between the TI 505 processors (545, etc.) is
accomplished over the Tl 505 back plane. The S3016-505 reads and
writesto the V memory of the T1 processor using the Tl task codes.
From the TI processor point of view, the V memory isread and
written to transparently by the S3016-505. No special
communications programming is implemented in the T1 processor.
The S3016-505 determines which V memory locations will be read
and written to.

Note: Only theV memory isread and written to by the S3016-505.
No other TI memory type reads and writes are supported by the
S3016-505.

On the S3016-505 side, the algorithm for implementing the task code
communication to the Tl processor is embedded in the S3016-505
firmware. The S3016-505 user program initiates the communication
by specifying which addresses will be read or written and how many
words are to be transferred. Once initiated, the task code is executed
transparently to the S3016-505 user program. See the “MCOM505”
program printout in appendix A for an example of the task code
communication to the Tl processor.
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SECTION 1

GENERAL DESCRIPTION

1.4 THE MCOMS05 APPLICATION PROGRAM

The primary purpose of the S3016-505 isto allow T1 505 based
processors to communicate with other S3000/M4000/S3016-505
processors. The SY Sdev “MCOM505” application program is loaded
into the S3016-505 and allows a Tl 505 processor to communicate
with up to 31 slave nodes, reading and writing up to 120 words to
each node. This program implements the task code communication to
the T1 505 processor as well asthe serial network communication to
the slave nodes. No additional programming is required by the user.

The communication between the T1-505 and the S3016-505 is
performed asynchronoudly, as is the communication between the
S3016-505 to the slave nodes over the S3000 seria network.

The operation of the “MCOM505” program is as follows:

1) The*MCOMS505" program reads the data from the T1-505
processor and stores thisin an internal buffer (of the S3016-505).
This datais then transmitted to a slave node.

2) Dataisthen read from a slave node (stored in an internal buffer of
the S3016-505) and written to the T1-505 processor. Thisis
performed in a sequential fashion for al sequences (0 to 30 or
nodes 2 through 32) that are enabled for communications. The
datathat is passed for each node is defined in section 4.4.

Note: Task code communication will not occur for any disabled
nodes (node number set to 0).

3) Oncethisdataisupdated (for al enabled nodes), the
communications status is then written to the TI-505 processor (see
section 4.9 for details on the status stack address data).

4) Thisprocessis continuously repeated, starting with the first
enabled node.

Note: Communication between the TI1-505 processor and the S3016-
505, is occurring concurrently thus optimizing the total through-put of
the system.

See section 2.4 for details on downloading the “MCOMS505” program
to the S3016-505.
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GENERAL DESCRIPTION

1.5 THE NETCOM SETUP PROGRAM

The“NETCOM” setup program is a menu driven program (Windows
or DOS based) and runs on a PC or Laptop computer. It isused to
configure and monitor the communication to between the Tl 505
processor and other S3000/N400/S3016-505 slave nodes. The
combination of the “MCOMS505” application program and the
“NETCOM” setup program turns the S3016-505 into a
communication board that allows the T1 505 processor to
communicate to up 31 slave nodes.

“NETCOM” configures the V memory addresses and the number of
“Words’ used for reading data“From” and writing data“ To” adave
node (W memory addresses). Once this information is downloaded to
the S3016-505, the communication between the TI processor and the
slave nodes is then performed automatically.

See section 3 for details on using the Windows based setup program.
See section 4 for details on using the DOS based setup program.
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SECTION 2
INSTALLATION

Caution: The internal components of the S3016-505 are
susceptible to damage by static discharge. When handling the
S3016-505, the board should be handled by the faceplate only
and preferably in a static shielding bag.

2.1 INSTALLING THE S3016-505 IN THE RACK
The S3016-505 can be installed in any 1/O dlot of the Tl 505 rack.

Install the S3016-505 as follows:

1) Turn power to the TI 505 rack “off”.

2) Install the S3016-505 in the rack by aligning the board with the
card guides and dliding in until firmly seated. The board is held in
the rack via captive screws located on the faceplate.

3) Connect the S3016-505 to the S3000 network by plugging the
network field wiring connector into the network comm port,
observing the proper keying of the connector.

4) Turn power to the T1 505 rack “on”.

5) Download “MCOM505” to the S3016-505 (see section 2.4).

To remove the S3016-505 from the rack, perform the
following:

1) Turn power to the TI 505 rack “off”.

2) Remove the network field wiring connector from the “Comm”
port.

3) Loosen the captive screws located on the faceplate and gently pull
the board out of the rack using the handles located on the
faceplate.
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INSTALLATION

2.2 S3000 SERIAL NETWORK INSTALLATION

The S3000 serial network installation consists of wiring the network
and setting each S3000/M 4000/S3016-505 node on the network with
aunigue network address. Up to 31 slave nodes can be connected to

the master S3016-505 on one network.

2.2.1 WIRING THE SERIAL NETWORK

Refer to figure 2.1 for atypical schematic of the network and for the
pin outs of the network interface connectors. When wiring the
network, the following rules must be followed:

1)

2)

3)

4)

5)

Wire the network using Belden #9182 single-shielded twisted pair
cable or an equivalent data communications cable meeting the
following spec:

Wire gauge: 22AWG
Nom. impedance: 150 ohmg/ft.
Nom. attenuationat 1 MHZ: _ .004 db/ft.
Twisted pair, single-shielded

The total wire length of the network cannot exceed 1,000 ft. if
344K BPS is selected, 2,000 ft. at 229K BPS, and 4,000 ft. at
106K BPS.

The shield of the cable should be carried through the entire
network, using the shield tie points on the interface connectors to
achieve this. The shield tie-points are strictly tie-points on the
connectors are not internally tied to anything. One of thesetie-
points should then be tied to earth ground.

The two extreme ends of the network should be terminated with a
150 ohm resistors as shown in figure 2.1.

The network wiring should be isolated from other high voltage
wiring by routing the network in a separate conduit dedicated to
the network.
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SECTION 2
INSTALLATION

6) The network should be wired directly to the network “Comm”
port connectors. No intermediate terminations or splices should be
used. The network should be wired in direct connect topology as
shown, not in multi-drop or cluster topologies.

Note: The network “Comm” interface connectors contain two sets of
+ and - terminals. The two sets of terminals are tied together internally
on the board (+ to +, - to -) and are provided as tie-points to ease
wiring. Communications across the network will continue even if one
of the nodes has failed provided all the connectors areinstalled in
thelir respective board. However, if aconnector is pulled fromit's
board, communications to the boards downstream will be lost (the
internal tie-point will be broken). If it is desired, this situation can be
avoided by wiring the connectors as shown in figure 2.2.

2.2.2 SETTING THE NETWORK ADDRESS IN THE SLAVE
NODES

When using the “MCOMS505” application program, the network
address of the S3016-505 is automatically set to address 1. For this
reason the S3016-505 network address does not have to be set by the
user. Each of the dave S3000/M4000/S3016-505 nodes on the
network must, however, be set by the user with a unique network
address between 2 and 32. Thisis how the S3016-505 can distinguish
one node from another.

To set the network address of a particular S3000/M 4000 node,
perform the following:

1) Connect the PC or Laptop computer running the Windows based
NETCOM setup program, from the “COM” port on the PC to the
“PROG PORT” on the respective S3000/M4000 node using a
SY Sdev RS-232 cable.

2) Fromthe*View” menu, select Target Board Interface. A
Windows Explorer type dialog box will appear, prompting the
user to select a SY Sdev program file.

3) Click the*Cancel” button. The “Target Board Interface” window
will appear and the setup program will attempt to establish
communications with the S3000/M 4000 node.
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SECTION 2
INSTALLATION

4) Select the “Set Network Address’ tab. The current network
address will be displayed

5) To change the address, enter the new addressin the field or use the
increment/decrement control to change the address. The network
address will be immediately changed.

6) Select “OK” to exit the Target Board Interface. The Setup
program will remain online with the Target Board. Press the F4
key to cease online communications.

Repeat the above steps for all S3000/M 4000 nodes on the network.
Thisistrue when the network isfirst installed, and when a new
S3000/M 4000 node is added or replaced on the network (that node
must have the network address set in it).

Note: System function sfunc19(); is used to set the network node
address and configure the $S4516 for the M4500 processor. See the
M4500 Program Development manual for more information on
setting the Network Station Address using system function sfunc19().

2.3 1/0 CONFIGURATION OF TI PROCESSORS FOR
S3016-505

The S3016-505 can be installed in any /O slot of the Tl 505 rack. The
S3016-505 is configured asa 3 word in/5 word out Special
Function module. Inthe Tl I/O module definition table the S3016-
505 should be defined as shown below:

I/0 Number of BIT and WORD 1/O Special
Slot Address X Y WX WY Function

XX XXXX 00 00 03 05 YES

Where XX and XX XX under “SLOT” and “1/0 ADDRESS’ are the
user defined dlots and 1/0 addresses where the S3016-505 is |ocated.
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SECTION 2
INSTALLATION

2.4 DOWNLOADING “MCOM505” TO THE S3016-505

With the S3016-505 powered up, perform the following to download
the “MCOM505” program to the S3016-505:

1)

2)

3)

4)

5)

6)

Connect the PC or Laptop computer, running the Windows based
NETCOM setup program, from the “COM” port on the PC to the
“PROG PORT” on the S3016-505 using a SY Sdev RS-232 cable.

Invoke the Windows based NETCOM setup program.

From the “File” menu, select “Download Program”. Select the
directory that contains the “MCOM505” application program.

Note: If “MCOM505” has not yet been loaded onto the hard
drive of the computer, perform the stepsin section 2.5 to load
“MCOM505” onto the computer.

Select the “MCOM505” program.
Follow the instructions on the screen to start the download
process. The current address being downloaded will be displayed

while program download isin progress.

Once the download is complete, the setup program will be left in
an “Online” edit mode.

See section 3 for complete details on using the Windows based
NETCOMM setup program.

2.5 INSTALLING “MCOM505” ON THE HARD DRIVE

1)

2)

3)

Create adirectory off the root that will be used to store the
“MCOM505” application program

Install the diskette that contains “MCOM505” into the floppy
drive.

Copy al files from the program diskette to the directory created to
store the “MCOM505” application program.
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SECTION 3
NETCOMM WINDOWS BASED
SETUP PROGRAM REFERENCE

The Windows based set-up program is menu driven, alowing the user
to easily view communication status or alter communication
parameters using a PC or Laptop computer running the Windows
(95/98/ME/2000/XP/NT) operating system.

Note: The set-up program is an on-line communications program
used to interface with the S3016-505. The data displayed and set in
the windows is communicated directly to the module, whilein the
“Online” edit mode. Therefore, prior to going online with the
processor, make sure an RS-232 cable is connected from the COM
port on the computer to the "PROG" port on the S3016-505. The
variables displayed while in the “Online”’ edit mode are read directly
from the processor. Datais saved to a*“ Set-up Data” file (*.sdt)
whenever changes are made to a parameter or if the datais uploaded
from the processor.

E HETCOMM - [unnamed] - [Main Display]

File Edit “iew Help
D 85 % uw =24

-~ Meszzages

-- Syztem MNarmal -- =
Set-up Program iz Currently OMLINE

Seqlt Node # | Carnrunication Status lﬂ
1] 2 02: Comm to Mode OF,

02 Comrm to Mode OF,

02: Comm to Mode OF,

00 Cornm Dizabled

00: Comm Dizabled

00 Comnm Dizabled

00: Comm Dizabled

00: Comm Dizabled

00 Comnm Dizabled

00: Comm Dizabled

00 Comm Dizabled

00; Comm Dizabled

00: Comm Dizabled

00: Comm Dizabled =

A

ra

[h}

=

o

o

(un]

=
o s B e Y e R s S s Y o A o ) s Y A R

Syztem Meszage: Al Faultz Normal OMLINE 1041172003 | 10:47 AM
| 2
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SECTION 3

NETCOMM WINDOWS BASED

SETUP PROGRAM REFERENCE

3.1 GENERAL DESCRIPTION

Title Bar: At thetop of the window isthe “Title Bar”. Thetitle bar
is used to display the name of the working “ Set-up Data’ file, aswell
as, the name of the active “Window”. Thetitle bar isdark if the
window is active and grayed if another window is active. The color
depends on the settings of the Display Properties of the Control Panel.

Tool Bar: At thetop of the window isa“Tool Bar”. The tool bar
allows the user to quickly execute those functions most often used.
These functions can also be executed from the drop down menus at
the top of the window. The following functions can be executed from

the tool bar:

D New...

N

H Save

% Print

Open...

This creates a completely new “ Setup” file, loaded
with the default variables and the word
“[unnamed]” isdisplayed in thetitle bar. If any
changes were made to the existing file, the user is
prompted to save changes to the existing file.

This displays adialog box allowing the user to
select an existing setup data file to open. The name
of the file will be displayed in the title bar.

Note: Existing “.NCM” files created by the DOS
based (NETCOM) setup program can be opened as
well.

This displays adialog box allowing the user to
select afolder and enter aname for the file. The
user will be notified if the file already exists and
the extension “.sdt” will automatically be added to
thefilename. If thisisa“New” file, the user will
be prompted to enter afile name.

This allows the user to generate a“ Report” printout
of al the communication settings and node
descriptions contained in the current setup datafile.

.’
Offline Edit Thisfunction allows the user to perform

“Offline” editing on the current set-up datafile.
This alows the user the ability to make any
necessary changes to the communication settings
while not online with the processor.
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SETUP PROGRAM REFERENCE

% Upload (save) Settings This allows the user to upload
(save) communication settings from the S3016-505
to a“Set-up Data’ file.

Download (restore) Settings Thisalowsthe user to
download communication settings to the S3016-
505. This can be the default setting or from a*“ Set-
up Data’ file.

Target Board Interface Thisallowsthe user to view fault
codes, S3000 network communication error codes
and review the current “ldent” and “Revision” of
the application program loaded into the S3016-505.

Communication Interface Thisallowsthe user to view
the data that is being passed to and from the Tl
processor and the slave node.

Status Bar: At the bottom of the window isthe “ Status Bar”. The
status bar is used to display system messages, online or offline mode,
aswell as, the current time and date as set by the operating system.
The system messages panel displays general information about
operation of the system. The Online/Offline mode panel displaysthe
status of the current set-up program mode of operation. The mode of
operation can be changed by simply double clicking the online/offline
mode panel.

Hot Keys: Hot keys are activated by holding down the “ALT” key
and simultaneously pressing the underlined letter of the desired
function. Almost every function can be activated by either pressing a
series of hot keys or using the “TAB” key to move between fields.

Online/Offline Modes: The set-up program allows the user to
make changes while “Online” with the processor. The “Offline”
mode is used to preset communication settings prior to download. All
functions are available to the user while “Onlineg”, however specific
“Online” functions are disabled in the “ Offline” edit mode.

Note: Offline changes can only be made by enabling “ Offline
Editing”, accessed under the “ Edit” menu or selecting the “ Edit” icon
from the tool bar.
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SECTION 3
NETCOMM WINDOWS BASED
SETUP PROGRAM REFERENCE

Getting Help: Pressing “Ctrl+H” will display the help file window.
Pressing the F1 key will display the contentsfile. Hot spots allow
jumps to other topicsto display additional information as desired.
Selecting “About NETCOMM?” from the Help menu will display a
dialog box listing information about the current revision of the setup
program and how to obtain technical support.

E HETCOMM - [unnamed] - [Main Display]
File Edit ‘“iew | Help

DEHE ¢
Sbout NETCOMM |

- Meszzages — |

-- Syztem MNarmal -- =
Set-up Program iz Currently OMLINE

LCanfiguration | Dezcriptions

Seqlt Node # | Carnrunication Status lﬂ
2 02: Comm to Mode OF,

02 Comrm to Mode OF,

02: Comm to Mode OF,

00 Cornm Dizabled

00: Comm Dizabled

00 Comnm Dizabled

00: Comm Dizabled

00: Comm Dizabled

00 Comnm Dizabled

00: Comm Dizabled

00 Comm Dizabled

00; Comm Dizabled

00: Comm Dizabled

00: Comm Dizabled =

o

OO | =0 O [ | e OO P [ —

o s B e Y e R s S s Y o A o ) s Y A R

Syztem Meszage: Al Faultz Normal OMLINE 1041172003 | 10:52 AR
| 2
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SECTION 3
NETCOMM WINDOWS BASED
SETUP PROGRAM REFERENCE

3.2 THE FILE MENU
The “File” menu allows the user to perform the following functions:

Create aNew “Set-up Data’ file

Open an existing “Data” (.sdt) or “Netcom” (.ncm) file

Save any changes made to the communications settings to disk
Upload (save) Settings from the Processor

Download a SY Sdev (.sdv) program to the S3016-505 (or any
other Systems processor)

Download (restore) Settings from a“ Set-up Data” file to the
processor

Print a Report of the communication settings

Exit the set-up program

E HETCOMM - [unnamed] - [Main Display]

File Edit Wiew Help

Crl+M k = EE
Open... Chrl+0
Save Chrl+5
Save fs... -- System Mormal - =
. Set-up Program iz Currently OMLINE
Upload (zave] Settingz
D ownload Program =
Download [restore] Settings
Frint Repoart. .. Chrl+F tioms
Exit on Statuz lﬂ
1] 2 02: Comm to Mode OF,
1 3 02 Comrm to Mode OF,
2 4 02: Comm to Mode OF,
3 1] 00 Cornm Dizabled
4 ] 00: Comm Dizabled
] 1] 00 Comnm Dizabled
5 ] 00: Comm Dizabled
7 1] 00: Comm Dizabled
a 1] 00 Comnm Dizabled
3 ] 00: Comm Dizabled
10 i] 00 Comm Dizabled
11 ] 00; Comm Dizabled
12 1] 00: Comm Dizabled
13 ] 00: Comm Dizabled =
| System Message: All Faults Mormal | DMUME  [10211/2003 [10:54 &M
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3.2.1 THE SET-UP DATA FILE

The “Set-up Data’” file (.sdt) isabinary accessfile, designed for fast
file1/O operation. When the set-up program isfirst invoked, the
default communication settings are loaded into memory. If changes
are made to any of these settings (either online or offline), the user
will be flagged to “ Save Changes’ upon exit of the program.

Note: Any windows based “ Set-up” program can open a “ Set-up
Data’ file, however, the data tables will not be properly aligned. The
user will be alerted to the problem if a set-up data file has been
created by either a different set-up program or a different revision of
the software.

The “Set-up Data” fileis similar to that of aword processing file.
When the program is loaded, the default communication settings are
loaded and the user is able to make any changes as desired. The set-
up program is unaware of the settings and parameters that exist within
the S3016-505. Therefore, to normalize the set-up program with the
processor, the user should define or open an existing file, then upload
“All” variables from the processor or click on the “Save” icon. This
allows the user to either create a backup of the data or maintain an
existing file. The user can even open adatafile for another S3016-
505, save the file to a new name, make the necessary changes and
simply download the new settings to another S3016-505.

The following functions can be accessed any time:

New: To create a“New” datafile, select “New” from the “File’
menu, press “ Ctrl + N” or click on the “New...” icon. Thisreplaces
the current settings with the default settings. If any changes were
made to the existing settings or file, the user is prompted first to save
changesto the existing file.

Note: Thefile name “[unnamed]” is displayed in the title bar when a
new fileisfirst created.
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Open: To“Open” and existing data (.sdt) or Netcom (.ncm) file,
select “Open” from the “File’” menu, press “Ctrl + O” or click on the
“Open...” icon. Thisdisplaysadialog box allowing the user to select
an existing file to open (default is“ Setup Files’, *.sdt”. The name of
thefileisthen displayed in the title bar.

Note: If any changes were made to the existing settings/file, the user
will be prompted to save any changes before opening a new file.

Save: To“Save’ the current settingsto disk, select “Save’ from the
“File” menu, press“Ctrl + S’ or select the“Save” icon. Thisdisplays
adialog box alowing the user to select afolder and enter a name for
thefile.

Note: If thisisa“New” file, the user will be prompted first to enter a
file name. The user will be notified if the file dready exists and the
extension “.sdt” will be added automatically.

Save As: To savethe settingsto a“New” file name, select “ Save
As’ from the “File” menu. Thisdisplays adialog box alowing the
user to select afolder and enter in anew name for the file. The user
will be notified if the file exists and the extension “.sdt” will be added
automatically to the file name.

Upload (save) Settings: The"Set-up” program alows the user to
upload communication settings from the S3016-505. Thisfunctionis
accessed from the “File” menu or by selecting the “Upload” icon.

Once invoked, the user is prompted to confirm their choice. If the set-
up programisin an “Offline” edit mode, the user is prompted to go
online with the processor to continue the process. If communication
can’'t be established or the user cancels the operation, the settings will
not be uploaded from the processor.

Download (restore) Settings: The set-up program allows the
user to download “Set-up” communication settings to the S3016-505.
This function is accessed from the “File” menu or by selecting the
“Download” icon.

Note: Only the values|oaded (from either a data or Netcom file) are
used. If thevalidity of the communication settings is questionable,
review the datain an “Offline” mode prior to download.
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3.2.2 DOWNLOAD PROGRAM

The “Set-up” program allows the user to “Download” any SY Sdev
program to the S3016-505.

Note: To“Download” a SY Sdev program to the processor, the set-
up program must be “Onling” with the S3016-505. If “Online’” mode
cannot be achieved, program download will not be executed. If the
program is currently “Offline”, the user will be prompted to first go
“Online”.

Once selected, and the set-up program “Online” with the processor, a
dialog box will be displayed, allowing the user to select the SY Sdev
file to download.

Note: Only the fileswith the“.sdv” file extension will be displayed.
It isimportant to keep in mind that only avalid S3016-505 SY Sdev
file should be downloaded to the processor. Care must be taken when
selecting a program to download.

A message box is then displayed informing the user of the current
program, revision and checksum of the program loaded in the
processor, aswell as, that of the selected program.

]
r@ Program to be loaded inta module [on disk):
g Program [dent: FMCOME05
Frogram Revizion; 42
Program Checksum: 5
Target Board: 53016
Program currently loaded in module:
Program Ident; MCOMB05E
Program Revizion: 44
Frogram Checksum: aa

Entire program file will be dumped to the FLC.
All outputs are off while program dump occurrs,

Do ou isth to Continue?

es Mo | Cancel |

The user must confirm their selection by clicking the “Yes’ command
button. Program download isinitiated and the current program
download addressis displayed. When program download is complete,
the user isalerted. Control is passed back to the main program and
the set-up program will remainin an “Online” edit mode.
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3.2.3 PRINT REPORT

The “Set-up” program allows the user to generate a“ Report” printout
of all the communication settings and node descriptions. This
function is accessed from the “File” menu.

At the top of each page, the report displays the name of the set-up file
being printed. At the bottom of each page is the date and time the
document was printed, as well as, the page number.

From the “File” menu, select “Print Report”, press “Ctrl + P’ or select
the “Print” icon. Thisdisplaysthe “Print Setup” dialog box, allowing
the user to select a printer, aswell as, the paper size and orientation.
Once the user selects “OK”, the report is generated and sent to the
specified printer device. This function makes use of the windows
print manager, which allows the user to continue with their work
while the document is being printed.

S3016-505 User’s Manual

SYSTEMS Electronics Group

-21-



SECTION 3
NETCOMM WINDOWS BASED
SETUP PROGRAM REFERENCE

3.3 THE EDIT MENU
The “Edit” menu allows the user to perform the following functions:

Enable/Disable Offline Editing
Set-up the Comm Port
Set the Tl Status Stack Address

E HETCOMM - [unnamed] - [Main Display]

File | Edit “iew Help

| D Enable Offine Editng~ F2 EE

Y Comnm Part Ctrl+hd

| Tl Status Stack Address -- System Mormal -- =]
et-up Program iz Currently OHLIME

| LConfiguration | Descriptions

Node # | Carnrunication Status lﬂ
2 02: Comm to Mode OF,
02 Comrm to Mode OF,
02: Comm to Mode OF,
00 Cornm Dizabled
00: Comm Dizabled
| 00: Camm Disabled
00: Comm Dizabled
00: Comm Dizabled
| 00: Carnm Dizabled
00: Comm Dizabled
00 Comm Dizabled
00; Comm Dizabled
00: Comm Dizabled
00: Comm Dizabled =

o s B e Y e R s S s Y o A o ) s Y A R

Syztem Meszage: Al Faultz Normal OMLINE  10/11,/2003 |1EI:5."" A
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3.3.1 ENABLE OFFLINE EDITING

This function allows the user to perform “ Offline” editing on the
currently loaded communication settings or edit the node descriptions.
This alows the user the ability to make any necessary changesto the
communication settings while not online with the S3016-505.

Note: If offline editing is not enabled, the user is only able to view
the settings and descriptions. When the program is first invoked,
offline editing is disabled.

The user will need to select “Enable Offline Editing” from the edit
menu, press function key F2 or select the “ Offline Edit” icon to
enable/disable this feature.

3.3.2 SETUP COMM PORT

This function allows the user to specify the serial communications
port and baud rate to talk to the S3016-505. The programming port of
the S3016-505 is set to 9600 baud.

ort Settings. ]
~ Comm Port ~ Port Speed |
" Com 1 + 9800
£ Com 2 19200
£ Com 3
= Com 4
Lancel |

Once selected, adialog box requesting the user to select a“Comm
Port” and “Baud Rate” will be displayed. The default setting is
COM 1 at 9600 baud.

In most cases, the user will only need to specify the communications
port and leave the baud rate at 9600. If communication problems
occur, make sure there is a secure connection from the PC to the PLC.
Then check the Comm port. In most cases the user will only need to
select anew Comm port. If communication problems persist, there
may be another program causing a conflict with the port. Check the
port configuration from the Windows “ Settings” folder.
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3.3.3 TI STATUS STACK ADDRESS

The TI-505 Communications Status stack is 32 consecutive V
memory locationsin the TI 505 processor, representing the
communications status of each node in the S3016-505. Once selected,
an “Input Box” is displayed, alowing the user to change the address.
If an invalid addressis entered, the new address will not be written to
the processor and the user alerted to the error. Thisselectionis
accessed from the “Edit” menu.

Tl Status Stack Address S _ﬁ

The T1-605 Communications Status Stack Address iz the ok
gharting addrezs of 32 consecutive ¥ memaony locations, -

The first ¥ memory location iz a 'Watchdog togole from _l:ancel I
the S3016-505. The remainder are the communication

zhatuz of the rezpective 31 Comm zequences [0 thiough
30

The Status stack can be located anpwhere within the
memory space M1 o W34463),

TI-505 Communications Status Stack Address W

Note: If “Offline” with the processor and “ Offline Editing” is not
enabled, this function is disabled.

Thefirst V memory location is a watchdog toggle from the S3016-
505. Thisistoggled between 0 and 1 once al the enabled nodes are
updated in the S3016-505. This should be monitored for a change of
state by the TI-505 program to verify that the S3016-505 is
functioning. Thisis generally accomplished with atimer that is reset
by a one shot fired every time thisV memory location changes from
either Otoaloraltoao.

Note: While the Node parameters are being downloaded to the
S3016-505, that this location will not change state. The timer should
be set to the maximum download time (approximately 5 seconds).
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Theremaining “V” memory locations are the status of the respective
32 communication sequences (the second V memory location is for
sequence 0, the third for sequence 1, etc.). The values loaded into
these locations are numbers between 0 and 19 decimal. These are the
same status codes as displayed in the “ Comm Status’ tab selection.
See section 3.5.1 for definitions of these codes. These status registers
should be monitored by the TI-505 program to verify communications
to a specific node is occurring.

When this selection is made, the current T1-505 Communications
Status stack addressis displayed. To change this address, simply type
in the desired V memory address and press <ENTER> otherwise,
press <ESC>. The address is then written to S3016-505.
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3.4 THE VIEW MENU

The“View” menu allows the user to perform the following functions:

View “Online” Data

View “Offline” Data

View the “ Target Board Interface”
View the “Communications Interface’

E HETCOMM - [unnamed] - [Main Display]

File  Edit | View Help

| D ﬁ Offline Data F4
-Messa
r Target Board Interface F5 P T—— =
Communication Interffiace FE pup Program is Currently OMLINE
LCanfiguration | Dezcriptions
Seqlt Node # | Carnrunication Status lﬂ
1] 2 02: Comm to Mode OF,
1 3 02 Comrm to Mode OF,
2 4 02: Comm to Mode OF,
3 1] 00 Cornm Dizabled
4 ] 00: Comm Dizabled
] 1] 00 Comnm Dizabled
5 ] 00: Comm Dizabled
7 1] 00: Comm Dizabled
a 1] 00 Comnm Dizabled
3 ] 00: Comm Dizabled
10 i] 00 Comm Dizabled
11 ] 00; Comm Dizabled
12 1] 00: Comm Dizabled
13 ] 00: Comm Dizabled =
| Syztem Meszage: Al Faultz Normal OMLINE  10/11,/2003 |11:DD A
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3.4.1 VIEW ONLINE DATA

This function alows the user to place the set-up program in an
“Online” mode with the processor. Thisis accessed from the “View”
menu by selecting “Online Data” or by smply pressing the “F3”
function key.

Note: The program can be toggled between “Offline” and “ Online”
modes by simply “Double Clicking” on the “Online” or * Offline”
panel displayed in the status bar at the bottom of the window.

Once invoked, the set-up program will attempt to open the Comm port
and communicate with the S3016-505. If the set-up programis
unsuccessful, a warning message will be displayed prompting the user
to either “Retry” or “Cancel” the operation. If the operationis
canceled and communication with the processor cannot be established
the system will be placed in an “Offline” edit mode.

Note: Anytime while the set-up programis*Online” with the
processor and communication is interrupted, a warning message will
be displayed, prompting the user to either “Retry” or “Cancel” the
operation.

3.4.2 VIEW OFFLINE DATA

This function allows the user to place the set-up program in an
“Offline” mode. Thisis accessed by the “View” menu, by selecting
“Offline Data’ or by simply pressing the “F4” function key. This
allows the user to perform “Offline” editing. All valuesdisplayedin
“Offline” edit mode reflect the actual values loaded into memory from
either a“Set-up Data’ file or the default settings.

Note: The program can be toggled between “Online” and “ Offline”
by ssimply double clicking on the “Online” or “Offline” panel
displayed in the status bar at the bottom of the window.

Once invoked, the set-up program will close the Comm port and cease
communication with the S3016-505.
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3.4.3 TARGET BOARD INTERFACE

This function allows the user to view fault codes, S3000 network
communication error codes, review the current “ldent” and
“Revision” of the application program, set the serial network node
address and set the time and date of the S3016-505. Thisis accessed
from the “View” menu or by clicking the Icon or by pressing the F5

key.

Once invoked, the set-up program will prompt the user to select a
program to compare with the one existing in the processor. Whether a
program is selected or the user cancels, the setup program will attempt
to communicate with the S3016-505. If unsuccessful awarning
message will be displayed, prompting the user to either “Retry” or
“Cancel” the operation. If the operation is canceled and
communication with the processor cannot be established the system
will be placed in an “ Offline” mode, however the “ Target Board
Interface” window will be displayed.

Fault Codes / Status | Program Ident/Revizion | Set Metwark Address | Set Time & Date

— Internal Fault Code:
Current Fault: Code = 00H

;Nn Intemal Fault has Ocuned.

Lazt Faulk: Code = 00H

!Nn Internal Fault has Ocured.

Corrective Action:

Mohe

~ Communications Hetwork Ermor Codes:
Current Comm Error: Code = 00H

;Nn Metwork Comm Error.

Lazt Carnmn Error: Code = O0H

;Nn Metwork Comm Error.
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3.4.4 COMMUNICATION INTERFACE

This function alows the user to view the dataas it’ s passed from the
TI processor to any selected slave node. Thisis accessed from the
“View” menu, by clicking theicon or pressing the F6 key.

Note: Theentire”Send” and “Receive’ buffer for each sequenceis
displayed and is only available when the setup program is “Online”
with the S3016-505.

Once invoked, the “ Communications Interface” window is displayed.
The user can select which sequence number to display the “ Send” and
“Receive’ buffer, aswell as view the particular communication
configuration. The data displayed is dynamic and reflects that which
is being communicated between the T1 processor and the slave node.

See section 3.5.2 for a description of the “ Settings” fields.

x
Sequence Humber; I E ﬁ
Mode Mumber: 2
Description: Deco 1 Statuz Data [(M4500]
Statuz: 02 Comm to Mode OF
- Settings:
Send Setting Receive Setting
# Words 120 # Words 120
From TI W00 From Hode w2000
To Mode w1000 TaTl W22
- Comm Data
Wiord Send Data | Receive Data ﬂ
1 2100 2000
2 2102 2002
3 2104 2004
4 2106 2006
5 2108 2003
5 2110 2o
7 2112 22
8 2114 2014
o 2116 206
10 2118 208 =
Ok
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3.5 THE MAIN DISPLAY

The“Main Display” displays the communication status of the S3016-
505, aswell as allows the user to view/edit communication settings
and descriptions for each communication sequence.

E HETCOMM - [unnamed] - [Main Display]

File Edit “iew Help

DE2E 85 % a 34

- Messages
-- System Mormal - =
Set-up Program iz Currently OMLINE
Seqlt Node # | Carnrunication Status lﬂ
1] 2 02: Comm to Mode OF,
1 3 02 Comrm to Mode OF,
2 4 02: Comm to Mode OF,
3 1] 00 Cornm Dizabled
4 ] 00: Comm Dizabled
] 1] 00 Comnm Dizabled
5 ] 00: Comm Dizabled
7 1] 00: Comm Dizabled
a 1] 00 Comnm Dizabled
3 ] 00: Comm Dizabled
10 i] 00 Comm Dizabled
11 ] 00; Comm Dizabled
12 1] 00: Comm Dizabled
13 ] 00: Comm Dizabled =
| System Message: All Faults Mormal | OMUME  [10211/2003 [11.034M

Note: Selecting a cell/parameter will allow the user to enter in a new
value. The “COMM Status’ tableis“Read Only” and will only
display the communication status when “Online” with the processor.

The variables are displayed in blue when either “Onling” or when
“Offline Edit” is enabled. Selecting a cell/parameter to edit will
display an entry box, with the current variable selected for editing,
displayed black.

Pressing the “ESC” key once will restore the original value, pressing
it asecond time will end the edit operation.
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Pressing the “Enter/Return” (or the up/down cursor) keys will validate
the entry. If the entry isvalid, the setting is updated. If the setup
program is“Online” with the processor, the value isimmediately
written to the S3016-505 and focus is moved to the next cell. If an
invalid entry is entered, a message box will be displayed indicating
the error and the focus returned to the original cell/parameter.

Thefollowing isalist of the functions of the “Main Display”.

3.5.1 THE COMM STATUS TAB

This selection is used to display the communications status with other
nodes while “Online” with the S3016-505. The status of each
communication sequence is displayed in a table with a status code and
short description. The status codes are the same as those passed to the
TI1-505 processor in the “ T1-505 communications status stack”.

The list of possible codes is shown below:

Code Code

(HEX) (decimal) Definition
OOH 00 Comm to Node Disabled
O1H 0
02H 02 Comm to Node OK
O3H 03 More than one bus master
04H 04 Xmitt timeout - no response
05H 05 No slave response - timeout
O6H 06 Invalid command from master
O7H o7 Receive overflow
08H 08 Receive collision detected
O09H 09 Receive alignment error
OAH 10 Receive CRC error
OBH 11 Unknown error
OCH 12 Xmitt no acknowledge
ODH 13 Xmitt under run error
OEH 14 Xmitt collision detected
OFH 15 Addressrange error
10H 16 Unexpected slave response
11H 17 TI1-505/S3016 read error
12H 18 TI1-505/S3016 write error
13H 19 Undefined error
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Status code O0H “Comm to Node Disabled” is set when node value of
a communications sequence is set to “0”. Thisisthe normal status
code for any unused nodes on the network. Status code 02H “Comm
to Node OK” isthe normal status code when anodeis enabled for
communications (valid node number of 2 to 32) and communication
to that node is successful. Status codes 03H through 10H are network
communication error codes. In this case, communication to the node
is enabled, however communications to that node was unsuccessful.
The data returned to the T1-505 processor for that node would not be
valid.

Refer to the S3016 User's Manual for a complete description of these
error codes.

Note: Thistableis updated continuously such that any changein the
communications status of any node is reflected in the table
immediately. If the RS-232 communications from the computer to the
S3016-505 cannot be established (cable not connected, etc.) or the
setup program isin an “ Offline” edit mode, the status table will
display “--: -” for each communication sequence in the table. This
indicates that the setup program is not “Online” with the S3016-505.
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3.5.2 THE CONFIGURATION TAB

The configuration tab is used to define the communications
parameters for each sequence.

= NE . =10l x|
File  Edit Help
DEE 85 % a4
- Meszzages
-- System Mormal - =
Set-up Program iz Currently OMLINE
COkiM Status  Configuration | Dezcriptions |
Seqlt Node # | # Send | Fram TI | ToMode | # Receive | From Mode | ToTl ﬂ
0 2 120 Y100 w1000 120 w1200 41000
1 3 10 Y100 w100 10 w200 Y1200
2 4 10 Y100 w100 10 w200 41300
3 15 0 W1 32 0 w32 W1
4 % 0 0 W1 32 1] 32 W1
5 0 0 W1 32 1] w32 W1
E 0 0 W1 32 ] 32 W1
7 0 0 W1 32 1] w32 W1
8 0 0 W1 w32 1] w32 W1
g 0 0 W1 32 1] 32 W1
10 0 0 W1 w32 1] 32 W1
11 0 0 W1 32 1] w32 W1
12 0 0 W1 w32 1] w32 W1
12 0 0 W1 32 1] w32 W1 =l
[ S pstem Message: All Faults Normal | OMUME  [10/11/2003 [11:058M

The following selections are available:

Node Number: Thisfield isused to specify the slave node number
for communications. When selected, enter a node number (0 or 2
through 32). Entering a“0” will disable the communications, entering
any number from 2 through 32 will enable communications to the
specified node. In addition, the next or previous node can be selected
by pressing the “Up” or “Down” cursor keys respectively.

Note: When configuring communications settings “ Online” it is best
to set the “Node Number” last after setting the other parameters.
When “Online”’, parameters are written directly to the processor,
immediately after being entered. Setting the “Node Number” last will
then enable communication to slave.
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Sending (writing) Data to Slave Node: Thefollowing three
fields are the communication parameters, which define the words sent
(written) from the T1-505 to the slave node:

# Send - # of Words to Send to Slave Node: Thisisthe
number of V memory words that will be transmitted to the slave
node. Thisisadecimal vaue between 0 and 120.

From TI - Starting Address in TI-505 of Words to Send:
Thisisthefirst address of a stack in the TI-505 processor that will
be sent to the respective slave node. Valid variable typeisV
memory only within the V- memory space of the Tl 505 processor.

To Node - Starting Address in Slave Node to Store Data:
Thisisthefirst address of a stack in the slave node where the
words sent from the master will be stored. Thisisa'W' word
address in the slave node processor (see respective user's manual
for slave node processor for valid "W' addresses).

Receiving (reading) Data from Slave Node: Thefollowing
three fields are the communication parameters, which define the
words received (read) from the slave node and stored in the TI-505
processor:

# Receive - # of Words to Read from Slave Node: Thisis
the number words that will be read from the slave node and stored
in V- memory locations of the T1-505 processor. Thisis adecimal
value between 0 and 120.

From Node - Starting Address in Slave Node to Read
Data: Thisisthefirst address of a stack in the slave node that
will be read from the slave node and sent to the T1-505. Thisisa
"W' word address in the slave node (see respective user's manual
for slave node processor for valid 'W' addresses and external
memory (HEX) addresses).

To Tl - Starting Address in TI-505 to store Data: Thisis
the first address of a stack in the T1-505 where the words read
from the slave node will be stored. ThisisaVV memory location in
the T1-505. Valid variable typeisV memory only within the V
memory space of the Tl 505 processor.
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3.5.2 THE DESCRIPTIONS TAB

Thisisthe description for the node (i.e. type of machine, type of dave
processor, etc., whatever is desired by the user to describe the node up

to 50 characters).
| ~loj x|
File Edit “iew Help
Ed 85 % uw =24
- Messages
-- System Mormal - =
Set-up Program iz Currently OMLINE
COkiM Status | Configuration  Descriptions |
Seq # Mode # | Communication Description lﬂ
1] 2 Deco 1 [M4500]
1 3 Bodymaker 11 [M4020) %
2 4 Bodymaker 12 [M4020)
3 0
4 1]
5 0
5 1]
7 1]
] ]
3 1]
10 0
11 0
12 ]
13 1] =l
yztem Message: aults Marma E
5 il All Faults N | OMLINE ~ [10/11/2003 I11 094M -
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The DOS based NETCOM setup program is used in conjunction with
the “MCOM505” application program for the S3016-505. The
combination of the *“MCOM505” and “NETCOM” programs turn the
S3016-505 into a communications board that allows the T1 505
processor to communicate with up to 31 S3000/M4000/S3016-505
dlave nodes, reading and writing up to 120 words to each node.

NETCOM allows the user to perform the following:

1) Upload Node communication parameters from S3016-505.

2) Download Node communication parameters to S3016-505.

3) Save Node communication parametersin afile.

4) Document slave node descriptions.

5) Print Node communication parameters and descriptions.

6) Create multiple network configuration files with up to 32 nodes
per file.

The “NETCOM” program consists of a shell (the menu displayed
when “NETCOM?” isfirst invoked), used for file and directory
control. From this menu files, which will store the node parameters,
are created, copied, backed up or restored.

When afileis selected or created, the Main menu is then invoked. The
user can then edit the node parameters, download, upload or prints the
communication parameters. The following sections describe the
menus and features of the “NETCOM” setup program.

4.1 INSTALLING AND RUNNING NETCOM

To install the program on a PC or Laptop computer, perform the
following:

1) Load the diskette into the floppy drive.

2) From aDOS command prompt, switch to the root directory and
type “A:INSTALL".

3) Theinstall program will create adirectory call “HSLSETUP’ and
copy the“NETCOM.EXE” program to this directory.

To execute the setup program, run the NETCOM .EXE file from the
“HSLSETUP’ directory. The program will be invoked and the
“NETCOM” shell will be displayed.
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If desired, the “NETCOM?” shell can be bypassed by including the
path (directory) and parameters file name in the command line when
“NETCOM” isinvoked. This allows a specific file to be automatically
invoked without having to go through the “NETCOM” shell for file
selection. The format of thisis asfollows:

HSLSETUP>NETCOM path filename<ENTER>

Where “path” is the directory\sub-directories that the file name is
under and “filename” isfile that contains the respective node
parameters.

Note: There must be a space between “NETCOM” and “path” and a
space between “path” and “filename’ in the above command line. No
extension is appended to “filename” in this command line as well.

Example:
C:\HSLSETUP\NETCOM.EXE \MCOM505\ NETTEST

Where “MCOM505” is adirectory off the root of the current drive
that contains afile named “NETTEST”.

Note: Only an existing file can be accessed when adding the path
and filename to the command line. New files must be created through
the “NETCOM” shell by invoking “NETCOM” with no path and
filename specified.
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4.2 “NETCOM” SHELL

The“NETCOM” shell is used to create and edit user files and
automatically invoke the main menu when afileis created or selected.
Sub-directories should be used to store and organize the user files.
These sub-directories can be created using the “F5: Make Dir”
command in the “NETCOM” shell.

L MIETEOM EXE

$3016-505 Metwork Communications Setup - VYersion 1.0

PROMPT: Select directory, Press Enter<CR* to accept, ESC to abort

DIR: ©C: FILE: TARGET BOARD: S316-5E5
FILE SELECTIONS: SUB-DIRECTORY SELECTIONS: |The Communications setup
* 386 PROGRA™L program allows the user
BACKUP RGADRLS to perform the following:
HWIHHT {1111 -lpload nodes from 53016
DISCOVER MG “Download nodes to 53016
KPCHS PRESEN"L -Save nodes in a file
INTSOFET YRPROG™L ~Document Hodes (SIBRES
PSFONTS SEABATS H&ad network slave node
YORNE PRWARE descriptions)
DELL STEMENHS -Print Hetwork Hode comm
YOP e pddreszes/descriptions
PROGRAMS i I -Create multipnle Network
HUTEMP E-HRIL configuration files with
DRIVERS S¥551 up to 32 nodes per file
DOCUME™1 SYS596 See the 53016505 User’s
PROJECT PL551 marwal for more details.
Create| Set |Select| Root | Make [Select| Copy |Backup|Restor|Delete|Exit to
File |Colors| Dir Dir Dir |Orive | File | File | File | File nos
i Tl i el B ol e e S Bl N P W il e SR B 1 R
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4.2.1 “NETCOM” SHELL MENU

The “NETCOM” shell consists of a menu which displays the selected
file name, current directory, target board along with fields that display
the existing file selections available for editing and available
directories. The definitions of these fields are as follows:

PROMPT:

DIR:

FILE:

FILE
SELECTIONS:

Thisfield displays various prompts to the user
based on the selected command, informing the user
what to do.

Thisfield displays the currently selected drive and
directory. Thisis set using the “F6: Select Drive:
and “F3: Select Dir” commands. When
“NETCOM” isinitially invoked, thisis set to the
root directory of the current drive.

Thisisthefile currently pointed to by the selection
arrow in the File Selections field of the menu. This
field is also used to enter the name of the user file
when the “F1: Create File’ command is executed.

Thisfield contains alist of the existing user filesin
the currently selected directory. The currently
selected file is the file pointed to by the selection
arrow. The selection arrow can be moved to any
displayed file using the Left, Right, Up and Down
arrow keys. When “NETCOM” isinitialy
invoked, thisdisplays al the “NETCOM” user files
in the root directory of the current drive.

SUB-DIRECTORY

SELECTIONS:

Thisfield contains alist of the existing sub-
directoriesin the currently selected directory. The
“F3: Select Dir” command is used to select one of
these directories as the current directory. When
initially invoked, this displays all the sub-
directoriesin the root of the current drive (whether
they contain “NETCOM” user files or not).
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4.2.2 “NETCOM” SHELL COMMANDS

The shell contains numerous commands for creating and editing the
user file, selecting the directory and drive the user files are stored in,
and execution DOS commands such as Backup, Copy, Delete, etc.
from within the shell. The definitions of these commands are as

follows:

F1:
Create File

F2:
Set Colors

F3:
Select Dir

F4:
Root Dir

This command is used to create a new user file.
When selected, the menu will prompt for the file
name. Enter the new nameinthe“FILE:” filed of the
menu using the valid DOS file name character set.

This selection allows the user to select the foreground
color (characters) and background color on PC’s
equipped with color monitors. Any of 16 foreground
colors and any of 8 background colors can be selected.

Thisisused to select adirectory. Only directories
within the current sub-directory are displayed and are
available for selection.

Pressing “F3" positions the selection arrow in the sub-
directories menu. Use the cursor keys to position the
selection arrow at the desired sub-directory and press
ENTER. The“DIR:” field will reflect the selected
directory, while the file selections menu will be
updated to show the existing user files.

This selection is used to set “DIR:” to the root
directory of the selected drive. Thiscommand is
primarily used to back out of the selected directory.
Pressing “F4” will set “DIR:” to the root directory and
display the user files and directoriesin the root
directory of the selected drive.

S3016-505 User’s Manual

SYSTEMS Electronics Group

-41 -



SECTION 4
NETCOM DOS BASED
SETUP PROGRAM REFERENCE

F5:
Make Dir

F6:
Select Drive

F7.
Copy File

F8:
Backup File

This selection creates a new sub-directory in the
currently selected directory. When selected, the menu
will prompt for the directory name. Enter the new
name using the valid DOS directory name character
set. The directory name can be a maximum of eight
charactersin length. Press ENTER to accept the
directory name. The new directory will now be
displayed in the sub-directories selection menu and
can now be selected as the current directory using the
“F3: Select Dir” command if desired.

This selection is used to change the currently selected
drive. When selected, the shell prompts for the drive
letter (A —Z). Enter the new drive and press ENTER.
The“DIR:” field will be changed to the root directory
of the new drive and the existing “NETCOM” user
files and sub-directories will be displayed.

This selection is used to copy the selected fileto a
new file name in the current directory. Enter the new
name using the valid DOS file name character set.
The file name can be a maximum of eight characters
in length (no extension should be entered). Press
ENTER to accept the file name that the selected file
will be copied to. The new file will then be displayed
in the file selections menu.

This selection is used to backup the selected file to the
root directory of a user specified diskette drive. When
selected, the shell prompts for the drive (A or B) that
the file will be backed up to. Enter the drive and press
ENTER. The currently selected file will be copied to
the root directory of the specified diskette.
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Restore File Thisselection is used to restore a previously backed

F10:
Delete File

up file form the root directory of a user specified drive
to the currently selected directory and file. When
selected, the shell prompts for the diskette drive (A or
B) that the file will be copied from. Enter the drive
and press ENTER. Thefilewill be copied from the
root directory of the specified drive to the currently
selected directory.

This selection del etes the selected file from the
current directory. When selected, the shell prompts
one time to verify that the fileisto be deleted, answer
“Y” to delete, “N” to abort. If yes, thefileisdeleted
from the file selections menu.

S3016-505 User’s Manual

SYSTEMS Electronics Group

-43-



SECTION 4
NETCOM DOS BASED
SETUP PROGRAM REFERENCE

4.3 MAIN MENU

The Main menu isinvoked after anew fileis created or when an
existing fileis selected from the shell.

The Main menu allows the user to edit the node communications
parameters, download node parameters, upload node parameters, print
node parameters, set the Tl 505 status stack address and monitor the
communications status on-line.

Note: When afileis created for the first time, the “ T1-505
Communications Status Stack address’” menu is displayed first (see
section 4.8). This forces the user to set this address prior to editing the
rest of the communications parameters.

The following describes these menu selections.

L MIETEOM EXE

Main Henu
1: FEdit Hode Communications Parameters
2: Download Parameters to SI016-505 (PROG PORT)
3: Upload Parameters from S3016-50% (PROG PORT)
h: Print Hode Communications Parometers
5 Set TI-505 Communication Status Stack Address
fi:  Mondtor Communication Status (PROG PORT)
Enter Selection (ESC to ewit):
mode 2
33000
node: 1 =lave
TI-505 | S3016-505 | 53008 Hetworlk .
rack | master .
node: 32
W& iR
slave
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4.4 EDIT NODE COMMUNICATIONS PARAMETERS

The Node Parameters Edit menu is used to define the communications
parameters of each node as well as enable or disable communications
to the node and enter descriptions for each node. The following
selections are available on this menu:

L MIETEOM EXE o ]

SYSTEMS 53016-505 Welwork Communications Setup - Har51on l ﬂ

Hode Parameters Edit wenu

gelect Node number

Edit Hode descriptzon

Fdit Hode Communication Parameters
Enable/Dizable Communications to Hode

i g =t

Enter Selection (ESC to ewit}):

Hode Mumber: 2
Hode Description: MESHR Test Module
Commmications to Node; Enabled

Hords zent from TI-5805 to Slave Hode
# of Words to zend from TI-595 te slave nnde.....: 20
Starting address in TI-505 of words to send. . ... . : Ya18a
Starting address in slave node to store words at,: W2008

Hords read from zlave node o TT-S005
£ of Words to read from slave node to TI-585, ... .: el
Starting address in slave node to read words frun HEEEE
Starting addre=zs in TI-5305 {0 store words at. .. . .

In addition to the above selections, this menu contains the following
fields:

Node Number: Thisisthe currently selected node for editing.

Node Description: Thisisthe description for the node (i.e. type of
machine, type of slave processor, etc., whatever is desired by the user
to describe the node up to 50 characters).

Communications to Node: Enabled/Disabled -Thisfield
indicates whether communications to the node is enabled or disabled.
When enabled the S3016-505 communicates to the respective node
using the parameters defined for that node (number of words,
addresses to transfer, etc.). Thisinformation is then communicated to
the T1 processor. When disabled, no communications is performed to
the respective node and no information is transferred to the Tl
processor. The communication parameter fields are also blanked when
the comm is disabled.
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Words sent from TI-505 to Slave Node: The following three
fields are the communication parameters, which define the words sent
from the TI-505 to the slave node:

# of Words to send from TI-505 to slave node: Thisisthe
number of V memory words that will be transmitted to the slave
node. Thisisadecimal vaue between 0 and 120.

Starting address in TI-505 of words to send: Thisisthe
first address of a stack in the TI1-505 processor that will be sent to
the respective slave node. Valid variable typeisV memory only
within the V- memory space of the Tl 505 processor.

Starting address in slave node to store words at: Thisis
the first address of a stack in the slave node where the words sent
from the master will be stored. Thisisa'W' word addressin the
slave node processor (see respective user's manual for slave node
processor for valid 'W' addresses).

Words read from slave node to TI-505: The following three
fields are the communication parameters, which define the words read
from the slave node and stored in the T1-505 processor:

# of Words to read from slave node to TI-505: Thisisthe
number words that will be read from the slave node and stored in
V memory locations of the T1-505 processor. Thisis adecimal
value between 0 and 120.

Starting address in slave node to read words from: This
isthe first address of a stack in the slave node that will be sent to
the TI-505. Thisisa'W' word address in the slave node (see
respective user's manual for slave node processor for valid 'W'
addresses and external memory addresses).

Starting address in TI-505 to store words at: Thisisthe
first address of a stack in the T1-505 where the words read from
the slave node will be stored. ThisisaV memory location in the
TI-505. Valid variable typeis V memory only within the V
memory space of the Tl 505 processor.
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4.4.1 SELECT NODE NUMBER

This selection is used to select the slave node number for editing.
When selected, enter the node number (2 through 32) to be edited. In
addition, the next or previous node can be selected by pressing the

“PgDn” or “Pgup” keys respectively.

4.4.2 EDIT NODE DESCRIPTION

This selection is used to edit the “Node Description” field. Thisfield
can be used to describe the slave node (type of machine, type of
processor, etc.). When selected, the cursor is placed at the beginning
of thisfield. Then enter the desired node description (up to 50
characters).

4.4.3 EDIT NODE COMMUNICATIONS PARAMETERS

This selection is used to modify the communication parameters. This
includes:

# of Words to send from T1-505 to slave node

Starting addressin TI-505 of words to send

Starting address in slave node to store words at

# of Words to read from slave node to T1-505

Starting address in slave node to read words from

Starting addressin TI-505 to store words at

If the node is not aready enabled for communications when this
selection is made, the user is prompted to enable communications. If
communications is not enabled, the communication parameters cannot
be set and the cursor will return to the Enter selection prompt.
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With the communications enabled, the following sequence will occur:
1) The cursor will be located in the “# of Words to send” field. Enter
the number of words to be sent and press <ENTER>.

2) The cursor will move to the “ Starting address in T1-505” field.
Enter the starting V memory address of the send stack (the “V” is
automatically prefixed to the beginning of the address) and press
<ENTER>.

3) The cursor will now move to the “ Starting address in the slave
node’ field. Enter the starting address in the slave that the words
sent will be stored at as either avalid “W” addressin the form
“Wxxxx” where xxxx is the address or as avalid external memory
HEX address in the form “xxxxH” where xxxx isthe HEX
address and press <ENTER>.

4) The cursor will now advance to the next three fields of the “Words
read from slave node to T1-505". Enter these in the same way that
the three previous fields were entered.

4.4.4 ENABLE/DISABLE COMMUNICATIONS TO NODE

This selection is used to enable or disable communications to the
node. When the node fileisfirst created, by default, communications
to all nodes is disabled. The user then enables communications only to
the respective nodes that are connected to the network. For instance, if
the S3016-505 is connected to only one other slave node,
communications to that node only should be enabled and all other
nodes should be disabled. If the S3016-505 is connected to two Slave
nodes, communications to those two nodes should be enabled and all
other nodes disabled and so on.

This selection ssimply toggles the “Enable” or “Disable” state of the
node. If the node is disabled, pressing “4: Enable/Disable” will enable
the node. If the node is disabled, pressing “4: Enable/Disable” will
disable the node.

Note: When the nodeis enabled, the communication parameters
values are shown in the parameter fields. When disabled, the fields are
blanked, even though the parameter values in those fields are still
retained in memory and are shown when the communicationsis
enabled again.
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When any of the descriptions or parameters are modified for any of
the nodes, the datais saved in the selected file when the “Node
Parameters Edit” menu is exited. The S3016-505 is not updated with
any changes until the “Download Parameters’ is performed to the
S3016-505.

4.5 DOWNLOAD PARAMETERS TO S3016-505

This selection is used to download the node communications
parameters for the slave nodes to the S3016-505 from the computer.

Note: The node descriptions are not downloaded to the S3016-505,
these are saved in the file on disk only. The download feature allows
the user to either download all the nodes (2 to 32) or just a range of
nodes (“starting” node and “ending” node) as specified by the user.
This allows just a certain number of nodes (i.e. nodes 2 to 4) to be
downloaded without having to download all the parameters for all the
nodes.

To download the node parameters, connect an RS-232 cable from the
COM port on the computer to the “PROG” port on the S3016-505 and
press this selection. The user is then prompted to abort the download
(by pressing “ESC”) or to continue (by pressing any other key). If any
key other than “ESC” is pressed, the following prompt is displayed:

wstems SIN6-583 Hetwork Communications paraweter download - Y1.8
opyright (] Svstems Flectronics Group. 193% - all rights reserved.

ata dump allows the communication parameters for all the slave nodes

{2-32) or a selected range of nodes to be downloaded to the 53016 [onswer

the following promptz accordingly) . If wvou do not want to download ang

ode data to the 53016, press ESE to abort. otherwize press any other

ey fo contime: 5
ownload all nodes to 53816-5057 {(vw/nl: n

nter starting node number to domnload (2-32): 2

nter ending node number to download (2-32): 2

ending paraneters for node: Q02

ata dump complete, press anv key:
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If “n” isanswered, the user is prompted for the starting node number.
Enter the starting node number and press Enter. The user is then
prompted for the ending node. Enter the ending node number and
press Enter. If, for instance, the parameters for nodes 10 through 20
are to be downloaded, Enter 10 at the starting node prompt and enter
20 at the ending node prompt.

In both cases, once the node download isinitiated, the current node
number being downloaded is displayed on the computer.

Note: Communication on the S3000 network, as well as between the
TI processor and S3016-505 is halted while the download isin
progress. Communication will automatically resume as soon as the
download is complete.

4.6 UPLOAD PARAMETERS FROM S3016-505

This selection is used to upload the node communications parameters
for the slave nodes from the S3016-505.

Note: The node descriptions are not uploaded these are saved in the
file on disk only. The upload feature alows the user to either upload
all the nodes (2 to 32) or just arange of nodes (“starting” node and
“ending” node) as specified by the user. Thisallows just acertain
number of nodes (i.e. nodes 2 to 4) to be uploaded without having to
upload parameters for all the nodes.

To upload the node parameters, connect an RS-232 cable from the
COM port on the computer to the “PROG” port on the S3016-505 and
press this selection. The user is then prompted to abort the upload (by
pressing “ESC”) or to continue (by pressing any other key). If any key
other than “ESC” is pressed, the following prompt is displayed:
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wstems SHN6-580 Hetwork Communications parameter opload - Y1.8
opyright (] Svstems Flectronics Group. 193% - all rights reseeved.

ata upload allows the communications parameters for all the slave nodes
r a selected range of nodes to be uploaded from the 53016 [anzmer the

the following prompitz accordingly) ond store them in the data file for

the current project. If vou do not want to upload any node parameters from
the 53016, press ESC to abort, otherwise press any other

ey to continue:

pload all nodes from $3016-5057 (winl: n
nter starting node nunber to upload (2-321: 2
nter ending node number to upload (2-32): 2
eading parameters for node: B2

ata read from $3016-505, Saving data at current path. ..
ata upload complete, press any kew:

If “n” isanswered, the user is then prompted for the starting node
number. Enter the starting node number to be uploaded and press
Enter. The user is then prompted for the ending node. Enter the
ending node number and press Enter. If, for instance, the parameters
for nodes 10 through 20 are to be uploaded, Enter 10 at the starting
node prompt and enter 20 at the ending node prompt.

In both cases, once the upload is initiated, the current node number
being uploaded is displayed on the computer.

Note: Communication on the S3000 network, as well as between the
TI processor and S3016-505 is halted while the upload isin progress.
Communication will automatically resume as soon as the upload is
complete.
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4.7 PRINT NODE COMMUNICATIONS PARAMETERS

This selection prints all the information on the “Edit Node
Communications Parameters’ menu:

The Node Number

Node Description

Communications Enabled/Disabled

Words Sent From Ti-505 To Slave Node

Words Read From Slave Node To Ti-505

If communications to a specific node is disabled, the Words sent and
read fields will not be printed. Similar to the download and upload,
the user can print the parameters for all the nodes (2-32) or just a
range of nodes.

The user will first be prompted for the form length. Thisis the number
of lines printed for each page and istypically 60. Enter the number of
lines per page and press Enter. Next the user is prompted “Print-out
parameters for all nodes (2 thru 32)? (y/n)”. If “n” isanswered the
user isthen prompted for the starting node number to print. Enter the
starting node number and press Enter. Next the ending node number is
prompted for. Enter the ending node number and press enter. For
instance, if nodes 10 thru 20 are to be printed, enter 10 for the starting
node and 20 for the ending node.

wstems SIN6-583 Hetwork Communications Paraweter Print - V1.8
opyright (] Systems Flectronics Group. 193% - all rights reserved.

nter Form Length (number of lines per pagel: 6B
rint-out poramsters for all nodes (2 thro 32)7 (pin): n
nter starting node number te print (2-32). 2

nter ending node number to print (2-32): 2

nter starting page nomber; 1
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Once the above prompts are answered, the print-out will be initiated.
Pressing “ESC” or any other key once the print-out is initiated will
abort the print-out.

4.8 SET TI-505 COMMUNICATIONS STATUS STACK
ADDRESS

The T1-505 Communications Status stack is 32 consecutive V
memory locationsin the TI 505 processor which represent the
communications status of each node in the S3016-505.

1 - METLCOM EXE

SYSTEMS 53016-505 Welwork Communications Setup - Harsmn l [1]

ol =1

TI-905 Communications Status Stack address..; V2081

The obowe addressz iz the ztarting oddress of the communications
status stack in the TI-585 processor. Thisz i1z 32 conzecutive

YV memory locations. The first V memory location is a watchdog
togyle from the S53016-505. This is toggled between 8 and 1 every
communication of the $3016-503 to the TI-58%. This should be
monitored for a change of state by the TI-GB5 program to verify
that the 53816-585 iz functioning. The remainder of the ¥ memory
locations of this stack are the commmications status of the
respective 31 slave nodes {(? through 32). This are the same status
codes displayed in the "Communications Status™ menu (zelection

& of the Moin menu). Theze communications stotus regizters should
monifored by the TI-585 program to werify that communications to a
specific node 15 occurring if that node iz enabled. The status
stack can be located anwwhers within the ¥ memory space.

Thefirst V memory location is a watchdog toggle from the S3016-
505. Thisistoggled between 0 and 1 once all the enabled nodes are
updated in the S3016-505. This should be monitored for a change of
state by the T1-505 program to verify that the S3016-505 is
functioning. Thisis generally accomplished with atimer that is reset
by a one shot fired every time thisV memory location changes from
eitherOtoaloraltoaO.

Note: While the Node parameters are being downloaded to the
S3016-505, that thislocation will not change state. Thus the timer
should be set to the maximum download time (approximately 5
seconds).
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The remainder of the V memory locations are the communication
status of the respective 31 slave nodes (the second V memory location
isfor node 2, the third for node 3, etc.). The values loaded into these
locations are numbers between 0 and 19 decimal. These are the same
status codes as displayed in the “ Communications Status” menu
(selection 6 of the Main menu). See section 4.9 for definitions of these
codes. These status registers should be monitored by the TI-505
program to verify that communications to a specific node is occurring.

When this selection is made, the current T1-505 Communications
Status stack address is displayed. To change this address, simply type
in the desired V memory address and press <ENTER> otherwise,
press <ESC>.

Note: Thisaddressisonly loaded into the S3016-505 when the
“Download Parameters to S3016-505" selection is performed. If this
address is changed, the parameters must be download to update the
S3016-505.

4.9 MONITOR COMMUNICATIONS STATUS (PROG PORT)

This selection is used to monitor the communications status on-line.
The status of each node is displayed in atable with a status code and
short description of each code. They are the same status codes passed
to the T1-505 processor in the “T1-505 communi cations status stack”.

SYSIENS S3016-505 Network Communications Setup - Version 1.0

— 0

x

Kode Communications Status (Press any kev to exit)

HODE  COWH STATUS NODE  COMH STATUS
2 B2H: Comm to Hode OK 18 B2H: Comm to Hode OK
3 B2H: Comm to Node 0K 19 A2H: Comm to Mode O
4 H: Comm to Node (OF pa |} B2H: Comm to Hode 0K
g WH: Comm to Node OF 21 @2H: Comm to Hode OK
f 02H: Comm to Node OK X2 @2H: Comm to Mode OK
7 2H: Comm to Node OK 23 A2H; Comm to Mode OK
il 02H: Comm to Mode 0K 24 @ZH; Comm to Hode 0K
4 BZ2H: Comm to Node 0K @Z2H; Comm to Mode 0K

18 0?H: Corm to Node 0K
11 U2H: Comm to Hode OK
12 MH: Comm to Mode OK
13 WH: Comm to Node OF
14 B2H: Comm to Hode OF
13 02H: Comm to Mode OK
16 WH: Comm to Node OK
17 B2H: Comm to Hode 0K

B2H: Comm to Mode 0K
B2H: Comm to Mode OK
A#H: Comm to Mode 0K
. Comm to Node OK
B2H: Comm to Hode OK
B2H: Comm to Node OK
A2H: Comm to Node OK

REEERNEY
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SECTION 4
NETCOM DOS BASED
SETUP PROGRAM REFERENCE

Thelist of possible codes is shown below:

Code Code

(HEX) (decimal) Definition
OOH 00 Comm to Node Disabled
O1H 0
02H 02 Comm to Node OK
O3H 03 More than one bus master
04H 04 Xmitt timeout - no response
O05H 05 No slave response - timeout
0O6H 06 Invalid command from master
O7H o7 Receive overflow
08H 08 Receive collision detected
09H 09 Receive alignment error
OAH 10 Receive CRC error
OBH 11 Unknown error
OCH 12 Xmitt no acknowledge
ODH 13 Xmitt under run error
OEH 14 Xmitt collision detected
OFH 15 Addressrange error
10H 16 Unexpected slave response
11H 17 TI1-505/S3016 read error
12H 18 TI1-505/S3016 write error
13H 19 Undefined error

Status code O0H “Comm to Node Disabled” is set when
communications to the respective node is disabled. Thisisthe normal
status code for any unused nodes on the network. Status code 02H
“Comm to Node OK” isthe normal status code when anodeis
enabled for communications and communications to that nodeis
successful. Status codes 03H through 10H are network
communication error codes. In this case, comm to the node was
enabled but communications to that node was not successful. The data
returned to the TI-505 processor for that node would not be valid.

Refer to the S3016 User's Manual for a complete description of these
error codes.
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SECTION 4

NETCOM DOS BASED
SETUP PROGRAM REFERENCE

To view the communications status, connect an RS-232 cable from
the COM port on the computer to the “PROG” port on the S3016-505
and press this selection. The status of each node will then be displayed
in the status table.

Note: Thistableisupdated continuously such that any changein the
communications status of any node is reflected in the table
immediately. If the RS-232 communications from the computer to the
S3016-505 cannot be established (cable not connected, etc.), the status
table will display *---: ------------ " for each node in the table. This
indicates that the computer is not communicating to the S3016-505.
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Board Size:
Length:
Height:
Width:

Processor Memory:
Program:

Data:
non-volatile:

volatile:
Flags (F):
Bytes (B):
Words (W):

I nterface Ports:
PROG PORT:
Type:
Comm Rate:

USER PORT:

Type:
Comm Rate:

Start bits:
Data bits:
Stop hits:
Parity:

Serial Network:
S3000-N1:
Type:

Comm Rate:

# of nodes (max):

| solation:
Distance:
Protocol:

Power Requirements:
Icc (+5VDC):

SECTION 5
SPECIFICATIONS

9.15"
6.30"
0.80"

24K bytes battery backed CMOS
RAM

2K bytes battery backed CMOS
RAM

104 bits
185 bytes
93 words

RS-232
9600 BAUD

RS-232/RS-422
300,600,1200,2400,4800,9600
BAUD

1

8

lor2

NONE, ODD, or EVEN

RS-485

344K BPS, 229K BPS, or
106KBPS

32

2000 VRMS

1000 ft., 2000 ft., or 4000ft.
Proprietary

1.00 amps (MAX)
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SECTION 5
SPECIFICATIONS

Temperature Range:
Storage: 0to 70 degreesC
Operating: 0to 60 degreesC
Relative Humidity: 5 to 95% (non-condensing)
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

System Configuration

Target board: S3016 Conmuni cations co-processor |1/0O board
Net wor k baud rate: 344KBPS

USER PORT baud rate: 9600

USER PORT parity: NONE

USER PORT stop bits: 1

Co- cpu communi cations interrupt enabled: no
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

R I R I I O R I I I I R I R I I I R R I I R R I O

bl ock: 1 - High-leve

FO010
B059
B090
B091
B105

: sfunc07(1900H, B9O) ;
: sfunc07(1901H, B91) ;

:sfunc08(1ff4H, 1);

:B105 = 2;
:F10 = 0O;
:B59 = 12;

(TIreset) TI 505
(Tt ) TI Task
(Verrstk) Vmem
(Verrstk) Vmem
(dwnl oad) down-

/* restore TI-505 com stack address */

r eset
Code
error
error
| oad

set node address to 1 (master) */
start in downl oad node until TI545 resets */

TI 505 reseting */

Tl Task Wit

conp
Wai t
st ack
st ack
node
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 2 - Assenbly

0: clr EX1 ; di sabl e conminterrupt from TI505
1:
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

R I R I R I R I I R R I R I I I R R O I R R R I O

bl ock: 1 - High-leve
** Sel ect state **

This bl ock searchs for enabl ed sl ave nodes (1st address of respective
sl ave buffer set to the slave nunber when enabl ed) and then initiates
the commcycle with the TI545. The data is read fromthe TI 545 and
stored in the slave xnmt buffer and then the data in the slave rcve
buffer is witten to the TI545. Once all slave nodes (2-32) have been
updated, the network comm (sfuncl3) error stack is witten to the

TI 545.

O:if (FO == 1) /* select state? */
1 {
2: F8 = 0; /* reset done bit */
3: for (B42 = B61 + 1; B42 < 33 && F8 == 0; ++B42)
4. {
5: /* search for enabl ed slave nodes and conmwi th TI545 */
6: W84 = (B42*512) +3c00H; /* point to nth node */
7. sfunc07( V84, B87) ;
8: if (B87 == B42) /* slave node enabl ed? */
9: {
10: W4 = W84 + 2; /* | oad comm paraneters */
11: sfunc07(V84, B62) ; /* # to send */
12: WB4 = W84 + 2;
13: sfunc07(VW84, B64); ++W84; [/* VSRCE address */
14: sfunc07(V84, B65) ; ++\W\84;
15: sfunc07(VW84, B66); ++W84; /[/* sdest address */
16: sfunc07(V84, B67) ; ++\W\84;
17: sfunc07(V84, B63); ++W84; /[/* # to receive */
18: ++W\84;
19: sfunc07(VW84, B68); ++W84; /[/* ssrce address */
20: sfunc07(V84, B69) ; ++\W\84;
21: sfunc07(W84, B70); ++W84; /[/* VDEST address */
22: sfunc07(VW84, B71) ;
23:
24 W4 = W84 + 3; /* point to xmt buffer */
25: B61 = B42; /* set slave address */
26: F8 = 1; /* done */
27: }
28: }
29:
30: if (F8 == 0) /* all nodes checked? */
31: {
32: B61 = 1; /* start with first slave node again */
33 B63 = 32; /* wite commerror status to TI545 */
34 W0 = W0, /* VDEST = VERROR_STACK */
35: W84 = 1bOOH,; /* point to commerror stack */
36: sfunc07(1b00H, B87); /* toggle S3016-505 (Tl545) watchdog */
37: B87.0 = ~B87. 0;
38: sf unc08( 1b00H, B87) ;
39: F4 = 1; /[* wite commerror status */
40: }
- bl ock continued on next page -
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

bl ock: 1 - High-leve
- block originated on prev page -
41. el se
42: F1 = 1; /* initiate read state */
43: }

45;FO = 0; /* exit select state */

FOOO0 (select ) sel ect sl ave state
FOO1 (read TI) read Tl 545 state
FO0O4 (writeTl) wite Tl 545 state

FO08 ( done ) done
B042 ( (i) ) | oop (i)
B0O61 ( slave ) network slave nunber
B062 ( #send ) # of words to send
B063 ( #rcve ) # of words to rcve
B064 ( Vsrce ) Vmem source address
B0O65 ( Vsrce ) Vmem source address
B066 ( sdest ) sl ave dest addr ess
B0O67 ( sdest ) sl ave dest addr ess
B068 ( ssrce ) sl ave source address
B069 ( ssrce ) sl ave source address
BO70 ( Vdest ) Vmem dest addr ess
BO71 ( Vdest ) Vmem dest addr ess
B087 (tenpregq) tenp registr
B087. 0(tregbt0) tenp reg bitO
W70 ( Vdest ) Vmem dest addr ess

W84 (slveptr) sl ave buf fer pointer
W90 (Verrstk) Vmem error st ack
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

R I I R I O R I O I I S R R I I R I I I R O I R R I O O

bl ock: 2 - High-leve
** Read state **

The next two bl ocks performthe first step of the comunication cycle to
the currently selected slave (read TI-545). In this state, the TI-545
Vmenory is read (the number of words specified in "#sent" starting

at "Vsrce") and |l oaded into the respective slave xmt buffer

(addresses 4000H to 7cO0H). This is the data that will be sent to

t he respective sl ave node.

O:if (F1L == 1) /* read state? */

1 {

2 if (F2 == 0) /* read from545 not yet initiated? */

3 {

4. B86 = &B182; /* initiate pointer to task code read buffer */
5: W88 = 1aOO0H,; /* initiate pointer to TI545 buffer */

6: if (B629%d5 == 0) /* even nunber of 15 word bl ocks to read? */
7 B35 = B62/15; /* yes, calc # of blocks to read */

8 el se

9: B35 = B62/15 + 1; /* calc # of blocks to read */

10: WB6 = Ws4-1; /* initiate Vaddr in 545 to read from*/

11: F2 = 1; /* read initiated */

12: B39 = 6; /* max nunber of error retries =6 */

13: }

14: }

15:

FOO1 (read TI) read Tl 545 state
FO02 (rd init) read state initiat
B035 (nunbl ks) # of bl ocks TI task
B0O39 (err cnt) TI task retry count

B062 ( #send ) # of words to send
B086 ( pntrl) t ask buf fer pointer
B182 ( rbuff ) tskcode read buf f er

W36 ( Vaddr ) Tl 545 Vmem  addr ess
W64 ( Vsrce ) Vmem source address
W88 ( pntr2 ) network buffer pointer
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 3 - High-leve

O:if (F1L == 1) /* read state? */

1 {

2: if (F103 == 0) /* task code with 545 conpl ete? */

3: { /* yes */

4. if (F102 == 1) /* task code commfailure with 54527 */

5: {

6: - - B39; /* dec error count */

7. if (B39 == 0) /* error retries count out? */

8: {

9: B40 = 11H, /* commerror = Tl _READ ERROR */

10: WL06 = 1bOOH + ((B61-1)<<1);

11: sfunc08(WL06, B40) ; ++WL06; /* save fault code in */

12: sf unc08(WL06, 0) ; /* TI-505 comm stat stack */
13: F1 =0, F2 =0, FO = 1; /* exit read state */

14

15: el se

16: F103 = 1; /* retry task code conmw th 545 */

17: F102 = 0; /* reset task code conmfail bit */

18:

19: else if (F9 == 1) /* task code conm done? */
20: {
21: for (B42 = 0; B42 < 15; ++B42) /* copy bl ock read from 545 */
22: { /* to network xmt buffer */
23: sfunc08( W88, *B86) ; ++B86, ++V\88; /* copy nth word */
24: sfunc08( W88, *B86); ++B86, ++W88
25: }

26: B86 = &B182; /* reset task code read buffer */

27: F9 = 0; /* block read done */

28: }

29: else if (B35 != 0) /* nore bl ocks to read? */

30: {

31: B56 = 50H; /* block read task code */

32: B57 = 4; /* # of bytes to xmt in task code req */
33: B58 = 32; /* # of bytes to rcve in task code resp */
34: WL50 = WB6; /* starting V mem address to read */
35: WB6 = WB6 + 15; /* next block address to read */

36: - - B35; /* dec # of blocks to read */

37: F103 = 1; /* initiate task code comm */

38: F9 = 1; /* preset block read done */

39: }
40: el se
41. {
42: W88 = 1aOO0H,; /* copy data read fromTI545 to */
43: while (B62 != 0) /* respective slave xmt buffer */
44:
45; sfunc07( V88, B87) ;
46: sfunc08( V84, B87); ++W84, ++\W88;
47: sfunc07( V88, B87) ;
48: sfunc08( V84, B87); ++W84, ++\W88;
49: --B62;

50: }

- bl ock continued on next page -
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

bl ock: 3 - High-leve

FO00
FO01
F002
F004
F009
F102
F103
B035
B039
B040
B042
B056
BO57
B058
B061
B062
B086
B087
B182
W36
w84
W88
WLO06
WL50

- block originated on prev page -

F1
W84

}
}
}

(sel ect )
(read TI)
(rd init)
(witeTl)
(TI done)
(tskfail)
(Tlcomm)
(nunbl ks)
(err cnt)
(commerr)
( () )
(tskcode)

( pntr2
(statptr
(Vst ack

—
D
-
D
«Q
N e e e e e S S e

=0, F2 0, F4
= (B61*512) +3c00H+256;
sel ect sl ave
read Tl 545
read state
wite Tl 545
Tl 545 t ask
Tl 545 t ask
Tl 545 t ask
# of bl ocks
Tl task retry
comm error
| oop

Tl 545 t ask

t ask code

t ask code
network sl ave
# of wor ds
t ask buf f er

tenp

t skcode read
TI 545 Virem
sl ave buf f er
net wor k buffer
comm status
Virem read

= 1; /* enter wite state */

state
state
initiat
state
done
fail
in prog
Tl task
count
code
(i)
code
#xmtt
#rcve
numnber
to send
poi nt er
registr
buf f er
addr ess
poi nt er
poi nt er
poi nt er
st ack

/* point to respective rcve buffer */
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 4 - High-leve
** Wite state **

The next two blocks wite the data that was read fromthe slave to the
Tl -545 Vmenory starting at "Vdest" (the nunber of words witten is

"#rcve").

O:if (F4 == 1) /* wite state? */

1.

2 if (F5 == 0) /* wite state not yet initiated? */

3 {

4. W88 = 1aOO0H,; /* copy data to be witten to TI545 from*/
5: for (B42 = B63; B42 > 0; --B42) /* respective slave rcve buffer */
6: {

7 sfunc07( V84, B87) ;

8 sf unc08( V88, B87) ;

9: ++W84, ++\W\88;

10: sfunc07( V84, B87) ;

11: sf unc08( V88, B87) ;

12: ++W84, ++\W\88;

13: }

14: B86 = &B152; /* initiate pointer to task code wite buffer */
15: W88 = 1aOO0H,; /* initiate pointer to TI545 buffer */
16: B35 = B63/14; /* nunber of blocks to to wite */

17: B43 = B63%l4; /* nunber of words remaining to wite */
18: WB6 = WO0-1; /* initiate Vmem dest address */

19: F5 = 1; /* wite state initiated */

20: B39 = 6; /* maxi mum # of error retries =6 */

21:

22: /* reset TI_READ ERROR */

23: WL06 = 1bOOH + ((B61-1)<<1);

24 sfunc07(WL06, B108) ;

25: if (B108 == 11H)

26: sf unc08( W06, 2);

27: }

28: }

29:

FO0O4 (writeTl) wite Tl 545 state
FOO5 (wr init) wite state initiat
B035 (nunbl ks) # of bl ocks TI task
B0O39 (err cnt) TI task retry count

W36
W70

Vaddr
Vdest

Tl 545 Vmem  addr ess
Virem dest addr ess

B042 ( (i) ) | oop (i)
B043 (#words ) # of words remain
BO61 ( slave ) network slave nunber
B063 ( #rcve ) # of words to rcve
B086 ( pntrl) t ask buf fer pointer
B087 (tenpregq) tenp registr
B108 (constat) conm status
B152 ( xbuff ) tskcode wite buf f er

( )

( )
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

bl ock: 4 - High-1evel

W84 (slveptr) sl ave buf fer pointer
W88 ( pntr2 ) network buffer pointer
WL06 (statptr) comm status pointer
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 5 - High-leve

O:if (F4 == 1) /* wite state? */

1 {

2: if (F103 == 0) /* task code with Tl 545 conplete? */

3: { /* yes */

4. if (F102 == 1) /* task code commfailure with 54527 */

5: {

6: - - B39; /* dec error count */

7. if (B39 == 0) /* naxi mum nunber of retries done? */

8: {

9: B40 = 12H, /* commerror = Tl _WRI TE_ERROR */

10: WL06 = 1bOOH + ((B61-1)<<1);

11: sf unc08(WL06, B40) ; ++WL06; /* save fault code in */
12: sf unc08(WL06, 0) ; /* TI-505 stat stack */
13: F4 =0, F5 =0, FO =1; /* exit wite state */

14

15: el se

16: F103 = 1; /* retry task code with 545 */

17: F102 = O;

18:

19: else if (B35 != 0) /* nore blocks to wite? */
20: {
21: B56 = 51H; /* block wite task code */
22: B57 = 32; /* nunber of task code bytes to wite */
23: B58 = 2; /* nunber of task code bytes to read */
24: WL50 = W\B6; /* Vmem start address */
25: WB6 = WB6 + 14; /* next block start address to wite */
26: - - B35; /* dec # of blocks to wite */

27: B86 = &B152; /* point to task code wite buffer */

28: for (B42 = 0; B42 < 14; ++B42)

29: {

30: sfunc07(VW88, *B86); ++W88, ++B86; /* copy from conm buffer */
31: sfunc07(VW88, *B86) ; ++W88, ++B86; /* to task code buffer */
32: }

33: F103 = 1; /* initiate tasck code conmwi th 545 */
34: }

35: else if (B43 = 0) /* write remaining words to 5457 */
36: {

37: B56 = 51H; /* block wite task code */

38: B57 = (B43 << 1) + 4; /* # of bytes to wite */

39: B58 = 2; /* # of bytes to read in task code */
40: WL50 = W\B6; /* Vmem start address */
41: B86 = &B152; /* point to task code wite buffer */
42: for (B42 = 0; B42 < B43; ++ B42)
43:
44 sfunc07( V88, *B86) ; /* copy nth word from conm buffer */
45: ++\W\88, ++B86; /* to task code wite buffer */
46: sfunc07( VW88, *B86) ;
47: ++W88, ++B86;
48: }
49: B43 = 0; /* reset # remaining */

50: F103 = 1; /* initiate task code comm */

- bl ock continued on next page -
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

bl ock: 5 - High-leve

FO00
F004
FO05
FO06
F102
F103
B035
B039
B040
B042
B043
B056
BO57
B058
B061
B086
B152
W36
W88
WLO06
WL50

- block originated on prev page -

}

el se

}

F4

}

(sel ect )
(witeTl)
(w init)
(condone)
(tskfail)
(Tlcomm)
(nunbl ks)
(err cnt)
(commerr)
( () )
(#words )
(tskcode)
(#xmtt )
#rcve )
sl ave )
pntrl )
xbuff )
Vaddr )
pntr2 )
(statptr)
(Vstack )

NN AN AN AN

=0, F5 0, F6
sel ect sl ave
wite Tl 545
wite state
TI 545 comm
Tl 545 t ask
Tl 545 t ask
# of bl ocks
Tl task retry
comm error
| oop
# of wor ds
Tl 545 t ask
t ask code
t ask code
network sl ave
t ask buf f er
tskcode wite
Tl 545 Vimem
net wor k buffer
comm status
Virem read

= 1; /* enter

state
state
initiat
done
fail
in prog
Tl task
count
code
(i)
remain
code
#xmtt
#rcve
numnber
poi nt er
buf f er
addr ess
poi nt er
poi nt er
st ack

done state */
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 6 - High-leve
** Comm networ k node sel ect state **

This bl ock searchs for enabl ed nodes and initiates the paraneters
and comuni cations with any enabl ed nodes.

0:if (F3 == 0 && B105 == 0) /* sel ect comm node? */
1 {
2: F8 = 0; /* reset done bit */
3: for (B42 = B96 + 1; B42 < 33 && F8 == 0; ++B42)
4. {
5: /* search for enabled nodes and initiate comm */
6: W2 = (B42*512) +3c00H; /* point to nth node */
7. sfunc07(V®2, B87) ;
8: if (B87 == B42) /* nth node enabl ed? */
9: {
10: B96 = B42; /[* initiate commw th node */
11: F8 =1
12:
13: el se
14: {
15: WL06 = 1bOOH + ((B42-1)<<1);
16: sfunc08(WL06, 0); ++WL06; /* set stat to "disabled" */
17: sf unc08( W06, 0) ; /* in TI-505 stat stack is not used */
18: }
19: }
20:
21: if (F8 == 0) /* all nodes checked? */
22: B96 = 1; /* yes, start again with first slave */
23: el se
24 {
25: W2 = W2 + 2; /* get paraneters for nth node */
26: sfunc07(V82, B97) ; /[* # to xmt */
27: W2 = Wp2+4;
28: sfunc07(V@2, B66); ++W92; /* sdest */
29: sfunc07(V82, B67); ++W\92;
30: sfunc07(V82, B98) ; /* # to rcve */
31: W2 = W92+2
32: sfunc07(V®2, B68); ++W92; /* ssrce */
33: sfunc07(V82, B69) ;
34: W2 = W92+5; /* point to nth node xmt buffer */
35: VW4 = 7eOaH, /* point to sfuncl3 buffer */
36: for (B42 = 0; B42 < B97; ++B42)
37: {
38: /* copy nth node xmt buffer to sfuncl3 buffer */
39: sfunc07(V®2, B87) ;
40: sf unc08( V@4, B87) ;
41: ++W02, ++\W\4;
42: sfunc07(V®2, B87) ;
43: sf unc08( V@4, B87) ;
44: ++W02, ++\W\4;
45; }
- bl ock continued on next page -
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APPENDIX A
MCOM505 PROGRAM PRINTOUT

bl ock: 6 - High-leve

FO03
FO08
B042
B066
B067
B068
B069
B087
B096
B097
B098
B105
W92
W94
WLO06

- block originated on prev page -

F3 =

(

( )
( )
( )
( )
( ssrce )
( ssrce )
(tenpregq)
( node )
( )
( #rcve )
(dwnl oad)
(nodeptr)
( pntr3)
(statptr)

1,

net wor k

sl ave
sl ave
sl ave
sl ave

net wor k
# of

# of
down-
node

comm

comm

| oop
dest
dest
source
source
tenp
node
wor ds
wor ds
| oad
buf f er
buf f er
st at us

/* initiate commstate */

state
done
(i)
addr ess
addr ess
addr ess
addr ess
registr
numnber
to xmt
to rcve
node
poi nt er
poi nt er
poi nt er
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APPENDIX A
MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 7 - High-leve
** network conm state **
This block perforns the comunications with the nth node, xnmitting

the previously | oaded sfuncl3 buffer and storing the data read from
the node at the node rcve buffer

O:if (F3 == 1) /* commstate */

1 {

2 w4 = 0; /[* conmwith nth node */

3 B38 = sfunc13(896 B97, *W4, *W66, B98, *\Ws8, *\\4) ;

4. if (B38 == 2) /* conn1done9 */

5: {

6: W2 = (B96*512) +3d0O0H;, /* point to nth node rcve buffer */
7 VW4 = 7eOaH, /* point to sfuncl3 buffer */

8 while (B98 != 0) /* copy data rcved to node buffer */
9:

10: sfunc07(V@4, B87) ;

11: sfunc08( V82, B87) ;

12: ++W02, ++\W\4;

13: sfunc07(V@4, B87) ;

14: sfunc08( V82, B87) ;

15: ++W02, ++\W\4;

16: - - B98;

17: }

18: }

19: if (B38 >= 2) /* comm not busy? */

20: {

21: W4 = ((B96-1)<<l) + 1b0O0OH; /* save error code */

22: sfunc08( V@4, B38) ; ++\W\4;

23: sfunc08( V84, 0) ;

24 if (B38 !=2) /* commerror? */

25: B40 = B38; /* save error code */

26: WL06 = 1bOOH + ((B96-1)<<1); [* save commreturn value in */
27: sfunc07(WL06, B108) ; /* test for TI _READWRITE error */
28: if (B108 < 11H)

29: {

30: sfunc08(WL06, B38) ; ++WL06; /* TI-505 stat stack */
31: sf unc08(WL06, 0) ;

32:

33: F3 = 0; /* exit commstate */

34: }

35: }

36:

FO03 (netcom) network comm state
B038 (sfl13ret) sfuncl3 return val ue
B040 (commerr) comm error code

B087 (tenpregq) tenp registr
B096 ( node ) network node nunber
B097 ( #xmt ) # of words to xmt
B098 ( #rcve ) # of words to rcve
S3016-505 User’s Manual SYSTEMS Electronics Group
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MCOM505 PROGRAM PRINTOUT

bl ock: 7 - High-leve

B108
W66
W68
W92
W94
WLO06

(const at)
( sdest )
( ssrce)
(nodeptr)
( pntr3)
(statptr)

sl ave
sl ave
node

comm

comm
dest

source
buf f er
buf f er
st at us

st at us
addr ess
addr ess
poi nt er
poi nt er
poi nt er

S3016-505 User’s Manual

- A-16 -

SYSTEMS Electronics Group
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MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 8 - High-leve

0:/* test for downl oad node and wait until conplete */
1.if (F6 == 1)

2 {

3 if (BLO5 == 0) /* not in downl oad npde? */

4. {

5: FO = 1; /* start next commcycle with TI */
6: F6 = 0;

7 }

8

9 /* reset TI_WRI TE_ERROR */

10: W06 = 1bOOH + ((B61-1)<<1):
11: sfunc07(WL06, B108) ;

12: if (B108 == 12H)

13: sf unc08( W06, 2);

14: }

15:

16:if (B105 != 0) /* downl oad node? */
17:

{
18: sfunc07(1900H,B90); /* restore Tl-505 conm status stack address */
19: sfunc07(1901H, B91) ;

20: }

21:

22:sfunc08(1ff4H, 1); /* set node address to 1 (naster) */
23:

FOOO0 (select ) sel ect sl ave state
FO06 (condone) Tl 545 comm done

BO61 ( slave ) network slave nunber
B090 (Verrstk) Vmem error st ack
B091 (Verrstk) Vmem error st ack
B105 (dwnl oad) down- | oad node

B108 (constat) conm status
WL06 (statptr) comm status pointer
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MCOM505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 9 - Assenbly

j nb F11, com enb ; power up TD conpl ete?

ib F10, com enb ; TI505 reset conplete?

anl h' c0, #h' fb ; reset Tl bus conplete latch

or | h' cO, #h' 4

j nb P3. 3, com enb ; TI505 still reseting?

clr | T1 ; level trigger on Tl bus intrpt
setb EX1 ; enabl e TI505 bus intrpt

setb F10 ; TI505 reset conplete

nov B105, #d' O ; enabl e task code an network comm
setb FO000 ; enabl e task code comm

=
QLN ARWNREO

11:E0n1enm

e
wn

FOO0 (select ) sel ect sl ave state
B105 (dwnl oad) down- | oad node
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MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 10 - Ladder

Power
Up
Ti mer TD
o + FO11
0: +--| T E SR E SR E SR E SR E SR +-()--
| P:#00015] Pw UpTD
| TB:1.00
| A Bl10
| (Pwr UpTD) |
| Power |
| Up |
1: | TD |
oo +
S3016-505 User’s Manual SYSTEMS Electronics Group
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MCOM505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 1 - High-leve

FO010
B059
B090
B091
B105

: sfunc07(1900H, B9O) ;
: sfunc07(1901H, B91) ;

:sfunc08(1ff4H, 1);

:B105 = 2;
:F10 = 0O;
:B59 = 12;

(TIreset) TI 505
(Tt ) TI Task
(Verrstk) Vmem
(Verrstk) Vmem
(dwnl oad) down-

/*

r eset
Code
error
error
| oad

restore TlI-505 com stack address */

set node address to 1 (master) */
start in downl oad node until TI545 resets */

TI 505 reseting */

Tl Task Wit

conp
Wai t
st ack
st ack
node
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MCOMS505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 2 - Assenbly

0: clr EX1 ; di sabl e conminterrupt from TI505
1:
S3016-505 User’s Manual SYSTEMS Electronics Group
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MCOM505 PROGRAM PRINTOUT

R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 1 - High-leve
** Sel ect state **

This bl ock searchs for enabl ed sl ave nodes (1st address of respective
sl ave buffer set to the slave nunber when enabl ed) and then initiates
the commcycle with the TI545. The data is read fromthe TI 545 and
stored in the slave xnmt buffer and then the data in the slave rcve
buffer is witten to the TI545. Once all slave nodes (2-32) have been
updated, the network comm (sfuncl3) error stack is witten to the

TI 545.

O:if (FO == 1) /* select state? */
1 {
2: F8 = 0; /* reset done bit */
3: for (B42 = B61 + 1; B42 < 33 && F8 == 0; ++B42)
4. {
5: /* search for enabl ed slave nodes and conmwi th TI545 */
6: W84 = (B42*512) +3c00H; /* point to nth node */
7. sfunc07( V84, B87) ;
8: if (B87 == B42) /* slave node enabl ed? */
9: {
10: W4 = W84 + 2; /* | oad comm paraneters */
11: sfunc07(V84, B62) ; /* # to send */
12: WB4 = W84 + 2;
13: sfunc07(VW84, B64); ++W84; [/* VSRCE address */
14: sfunc07(V84, B65) ; ++\W\84;
15: sfunc07(VW84, B66); ++W84; /[/* sdest address */
16: sfunc07(V84, B67) ; ++\W\84;
17: sfunc07(V84, B63); ++W84; /[/* # to receive */
18: ++W\84;
19: sfunc07(VW84, B68); ++W84; /[/* ssrce address */
20: sfunc07(V84, B69) ; ++\W\84;
21: sfunc07(W84, B70); ++W84; /[/* VDEST address */
22: sfunc07(VW84, B71) ;
23:
24 W4 = W84 + 3; /* point to xmt buffer */
25: B61 = B42; /* set slave address */
26: F8 = 1; /* done */
27: }
28: }
29:
30: if (F8 == 0) /* all nodes checked? */
31: {
32: B61 = 1; /* start with first slave node again */
33 B63 = 32; /* wite commerror status to TI545 */
34 W0 = W0, /* VDEST = VERROR_STACK */
35: W84 = 1bOOH,; /* point to commerror stack */
36: sfunc07(1b00H, B87); /* toggle S3016-505 (Tl545) watchdog */
37: B87.0 = ~B87. 0;
38: sf unc08( 1b00H, B87) ;
39: F4 = 1; /[* wite commerror status */
40: }
- bl ock continued on next page -
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bl ock: 1 - High-leve
- block originated on prev page -
41. el se
42: F1 = 1; /* initiate read state */
43: }

45;FO = 0; /* exit select state */

FOOO0 (select ) sel ect sl ave state
FOO1 (read TI) read Tl 545 state
FO0O4 (writeTl) wite Tl 545 state

FO08 ( done ) done
B042 ( (i) ) | oop (i)
B0O61 ( slave ) network slave nunber
B062 ( #send ) # of words to send
B063 ( #rcve ) # of words to rcve
B064 ( Vsrce ) Vmem source address
B0O65 ( Vsrce ) Vmem source address
B066 ( sdest ) sl ave dest addr ess
B0O67 ( sdest ) sl ave dest addr ess
B068 ( ssrce ) sl ave source address
B069 ( ssrce ) sl ave source address
BO70 ( Vdest ) Vmem dest addr ess
BO71 ( Vdest ) Vmem dest addr ess
B087 (tenpregq) tenp registr
B087. 0(tregbt0) tenp reg bitO
W70 ( Vdest ) Vmem dest addr ess

W84 (slveptr) sl ave buf fer pointer
W90 (Verrstk) Vmem error st ack
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R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 2 - High-leve
** Read state **

The next two bl ocks performthe first step of the comunication cycle to
the currently selected slave (read TI-545). In this state, the TI-545
Vmenory is read (the number of words specified in "#sent" starting

at "Vsrce") and |l oaded into the respective slave xmt buffer

(addresses 4000H to 7cO0H). This is the data that will be sent to

t he respective sl ave node.

O:if (F1L == 1) /* read state? */

1 {

2 if (F2 == 0) /* read from545 not yet initiated? */

3 {

4. B86 = &B182; /* initiate pointer to task code read buffer */
5: W88 = 1aOO0H,; /* initiate pointer to TI545 buffer */

6: if (B629%d5 == 0) /* even nunber of 15 word bl ocks to read? */
7 B35 = B62/15; /* yes, calc # of blocks to read */

8 el se

9: B35 = B62/15 + 1; /* calc # of blocks to read */

10: WB6 = Ws4-1; /* initiate Vaddr in 545 to read from*/

11: F2 = 1; /* read initiated */

12: B39 = 6; /* max nunber of error retries =6 */

13: }

14: }

15:

FOO1 (read TI) read Tl 545 state
FO02 (rd init) read state initiat
B035 (nunbl ks) # of bl ocks TI task
B0O39 (err cnt) TI task retry count

B062 ( #send ) # of words to send
B086 ( pntrl) t ask buf fer pointer
B182 ( rbuff ) tskcode read buf f er

W36 ( Vaddr ) Tl 545 Vmem  addr ess
W64 ( Vsrce ) Vmem source address
W88 ( pntr2 ) network buffer pointer
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R I R I I O R I O I I R R R I R I I I R R O I R R S S

bl ock: 3 - High-leve

O:if (F1L == 1) /* read state? */

1 {

2: if (F103 == 0) /* task code with 545 conpl ete? */

3: { /* yes */

4. if (F102 == 1) /* task code commfailure with 54527 */

5: {

6: - - B39; /* dec error count */

7. if (B39 == 0) /* error retries count out? */

8: {

9: B40 = 11H, /* commerror = Tl _READ ERROR */

10: WL06 = 1bOOH + ((B61-1)<<1);

11: sfunc08(WL06, B40) ; ++WL06; /* save fault code in */

12: sf unc08(WL06, 0) ; /* TI-505 comm stat stack */
13: F1 =0, F2 =0, FO = 1; /* exit read state */

14

15: el se

16: F103 = 1; /* retry task code conmw th 545 */

17: F102 = 0; /* reset task code conmfail bit */

18:

19: else if (F9 == 1) /* task code conm done? */
20: {
21: for (B42 = 0; B42 < 15; ++B42) /* copy bl ock read from 545 */
22: { /* to network xmt buffer */
23: sfunc08( W88, *B86) ; ++B86, ++V\88; /* copy nth word */
24: sfunc08( W88, *B86); ++B86, ++W88
25: }

26: B86 = &B182; /* reset task code read buffer */

27: F9 = 0; /* block read done */

28: }

29: else if (B35 != 0) /* nore bl ocks to read? */

30: {

31: B56 = 50H; /* block read task code */

32: B57 = 4; /* # of bytes to xmt in task code req */
33: B58 = 32; /* # of bytes to rcve in task code resp */
34: WL50 = WB6; /* starting V mem address to read */
35: WB6 = WB6 + 15; /* next block address to read */

36: - - B35; /* dec # of blocks to read */

37: F103 = 1; /* initiate task code comm */

38: F9 = 1; /* preset block read done */

39: }
40: el se
41. {
42: W88 = 1aOO0H,; /* copy data read fromTI545 to */
43: while (B62 != 0) /* respective slave xmt buffer */
44:
45; sfunc07( V88, B87) ;
46: sfunc08( V84, B87); ++W84, ++\W88;
47: sfunc07( V88, B87) ;
48: sfunc08( V84, B87); ++W84, ++\W88;
49: --B62;

50: }

- bl ock continued on next page -
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bl ock: 3 - High-leve

FO00
FO01
F002
F004
F009
F102
F103
B035
B039
B040
B042
B056
BO57
B058
B061
B062
B086
B087
B182
W36
w84
W88
WLO06
WL50

- block originated on prev page -

F1
W84

}
}
}

(sel ect )
(read TI)
(rd init)
(witeTl)
(TI done)
(tskfail)
(Tlcomm)
(nunbl ks)
(err cnt)
(commerr)
( () )
(tskcode)

( pntr2
(statptr
(Vst ack

—
D
-
D
«Q
N e e e e e S S e

=0, F2 0, F4
= (B61*512) +3c00H+256;
sel ect sl ave
read Tl 545
read state
wite Tl 545
Tl 545 t ask
Tl 545 t ask
Tl 545 t ask
# of bl ocks
Tl task retry
comm error
| oop

Tl 545 t ask

t ask code

t ask code
network sl ave
# of wor ds
t ask buf f er

tenp

t skcode read
TI 545 Virem
sl ave buf f er
net wor k buffer
comm status
Virem read

= 1; /* enter wite state */

state
state
initiat
state
done
fail
in prog
Tl task
count
code
(i)
code
#xmtt
#rcve
numnber
to send
poi nt er
registr
buf f er
addr ess
poi nt er
poi nt er
poi nt er
st ack

/* point to respective rcve buffer */
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R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 4 - High-leve
** Wite state **

The next two blocks wite the data that was read fromthe slave to the
Tl -545 Vmenory starting at "Vdest" (the nunber of words witten is

"#rcve").

O:if (F4 == 1) /* wite state? */

1.

2 if (F5 == 0) /* wite state not yet initiated? */

3 {

4. W88 = 1aOO0H,; /* copy data to be witten to TI545 from*/
5: for (B42 = B63; B42 > 0; --B42) /* respective slave rcve buffer */
6: {

7 sfunc07( V84, B87) ;

8 sf unc08( V88, B87) ;

9: ++W84, ++\W\88;

10: sfunc07( V84, B87) ;

11: sf unc08( V88, B87) ;

12: ++W84, ++\W\88;

13: }

14: B86 = &B152; /* initiate pointer to task code wite buffer */
15: W88 = 1aOO0H,; /* initiate pointer to TI545 buffer */
16: B35 = B63/14; /* nunber of blocks to to wite */

17: B43 = B63%l4; /* nunber of words remaining to wite */
18: WB6 = WO0-1; /* initiate Vmem dest address */

19: F5 = 1; /* wite state initiated */

20: B39 = 6; /* maxi mum # of error retries =6 */

21:

22: /* reset TI_READ ERROR */

23: WL06 = 1bOOH + ((B61-1)<<1);

24 sfunc07(WL06, B108) ;

25: if (B108 == 11H)

26: sf unc08( W06, 2);

27: }

28: }

29:

FO0O4 (writeTl) wite Tl 545 state
FOO5 (wr init) wite state initiat
B035 (nunbl ks) # of bl ocks TI task
B0O39 (err cnt) TI task retry count

W36
W70

Vaddr
Vdest

Tl 545 Vmem  addr ess
Virem dest addr ess

B042 ( (i) ) | oop (i)
B043 (#words ) # of words remain
BO61 ( slave ) network slave nunber
B063 ( #rcve ) # of words to rcve
B086 ( pntrl) t ask buf fer pointer
B087 (tenpregq) tenp registr
B108 (constat) conm status
B152 ( xbuff ) tskcode wite buf f er

( )

( )
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bl ock: 4 - High-1evel

W84 (slveptr) sl ave buf fer pointer
W88 ( pntr2 ) network buffer pointer
WL06 (statptr) comm status pointer
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R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 5 - High-leve

O:if (F4 == 1) /* wite state? */

1 {

2: if (F103 == 0) /* task code with Tl 545 conplete? */

3: { /* yes */

4. if (F102 == 1) /* task code commfailure with 54527 */

5: {

6: - - B39; /* dec error count */

7. if (B39 == 0) /* naxi mum nunber of retries done? */

8: {

9: B40 = 12H, /* commerror = Tl _WRI TE_ERROR */

10: WL06 = 1bOOH + ((B61-1)<<1);

11: sf unc08(WL06, B40) ; ++WL06; /* save fault code in */
12: sf unc08(WL06, 0) ; /* TI-505 stat stack */
13: F4 =0, F5 =0, FO =1; /* exit wite state */

14

15: el se

16: F103 = 1; /* retry task code with 545 */

17: F102 = O;

18:

19: else if (B35 != 0) /* nore blocks to wite? */
20: {
21: B56 = 51H; /* block wite task code */
22: B57 = 32; /* nunber of task code bytes to wite */
23: B58 = 2; /* nunber of task code bytes to read */
24: WL50 = W\B6; /* Vmem start address */
25: WB6 = WB6 + 14; /* next block start address to wite */
26: - - B35; /* dec # of blocks to wite */

27: B86 = &B152; /* point to task code wite buffer */

28: for (B42 = 0; B42 < 14; ++B42)

29: {

30: sfunc07(VW88, *B86); ++W88, ++B86; /* copy from conm buffer */
31: sfunc07(VW88, *B86) ; ++W88, ++B86; /* to task code buffer */
32: }

33: F103 = 1; /* initiate tasck code conmwi th 545 */
34: }

35: else if (B43 = 0) /* write remaining words to 5457 */
36: {

37: B56 = 51H; /* block wite task code */

38: B57 = (B43 << 1) + 4; /* # of bytes to wite */

39: B58 = 2; /* # of bytes to read in task code */
40: WL50 = W\B6; /* Vmem start address */
41: B86 = &B152; /* point to task code wite buffer */
42: for (B42 = 0; B42 < B43; ++ B42)
43:
44 sfunc07( V88, *B86) ; /* copy nth word from conm buffer */
45: ++\W\88, ++B86; /* to task code wite buffer */
46: sfunc07( VW88, *B86) ;
47: ++W88, ++B86;
48: }
49: B43 = 0; /* reset # remaining */

50: F103 = 1; /* initiate task code comm */

- bl ock continued on next page -

S3016-505 User’s Manual SYSTEMS Electronics Group

- A-29 -



APPENDIX A
MCOM505 PROGRAM PRINTOUT

bl ock: 5 - High-leve

FO00
F004
FO05
FO06
F102
F103
B035
B039
B040
B042
B043
B056
BO57
B058
B061
B086
B152
W36
W88
WLO06
WL50

- block originated on prev page -

}

el se

}

F4

}

(sel ect )
(witeTl)
(w init)
(condone)
(tskfail)
(Tlcomm)
(nunbl ks)
(err cnt)
(commerr)
( () )
(#words )
(tskcode)
(#xmtt )
#rcve )
sl ave )
pntrl )
xbuff )
Vaddr )
pntr2 )
(statptr)
(Vstack )

NN AN AN AN

=0, F5 0, F6
sel ect sl ave
wite Tl 545
wite state
TI 545 comm
Tl 545 t ask
Tl 545 t ask
# of bl ocks
Tl task retry
comm error
| oop
# of wor ds
Tl 545 t ask
t ask code
t ask code
network sl ave
t ask buf f er
tskcode wite
Tl 545 Vimem
net wor k buffer
comm status
Virem read

= 1; /* enter

state
state
initiat
done
fail
in prog
Tl task
count
code
(i)
remain
code
#xmtt
#rcve
numnber
poi nt er
buf f er
addr ess
poi nt er
poi nt er
st ack

done state */
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R I R I I O R R I I O I I R I I I R R O I I R R S

bl ock: 6 - High-leve
** Comm networ k node sel ect state **

This bl ock searchs for enabl ed nodes and initiates the paraneters
and comuni cations with any enabl ed nodes.

0:if (F3 == 0 && B105 == 0) /* sel ect comm node? */
1 {
2: F8 = 0; /* reset done bit */
3: for (B42 = B96 + 1; B42 < 33 && F8 == 0; ++B42)
4. {
5: /* search for enabled nodes and initiate comm */
6: W2 = (B42*512) +3c00H; /* point to nth node */
7. sfunc07(V®2, B87) ;
8: if (B87 == B42) /* nth node enabl ed? */
9: {
10: B96 = B42; /[* initiate commw th node */
11: F8 =1
12:
13: el se
14: {
15: WL06 = 1bOOH + ((B42-1)<<1);
16: sfunc08(WL06, 0); ++WL06; /* set stat to "disabled" */
17: sf unc08( W06, 0) ; /* in TI-505 stat stack is not used */
18: }
19: }
20:
21: if (F8 == 0) /* all nodes checked? */
22: B96 = 1; /* yes, start again with first slave */
23: el se
24 {
25: W2 = W2 + 2; /* get paraneters for nth node */
26: sfunc07(V82, B97) ; /[* # to xmt */
27: W2 = Wp2+4;
28: sfunc07(V@2, B66); ++W92; /* sdest */
29: sfunc07(V82, B67); ++W\92;
30: sfunc07(V82, B98) ; /* # to rcve */
31: W2 = W92+2
32: sfunc07(V®2, B68); ++W92; /* ssrce */
33: sfunc07(V82, B69) ;
34: W2 = W92+5; /* point to nth node xmt buffer */
35: VW4 = 7eOaH, /* point to sfuncl3 buffer */
36: for (B42 = 0; B42 < B97; ++B42)
37: {
38: /* copy nth node xmt buffer to sfuncl3 buffer */
39: sfunc07(V®2, B87) ;
40: sf unc08( V@4, B87) ;
41: ++W02, ++\W\4;
42: sfunc07(V®2, B87) ;
43: sf unc08( V@4, B87) ;
44: ++W02, ++\W\4;
45; }
- bl ock continued on next page -
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MCOM505 PROGRAM PRINTOUT

bl ock: 6 - High-leve

FO03
FO08
B042
B066
B067
B068
B069
B087
B096
B097
B098
B105
W92
W94
WLO06

- block originated on prev page -

F3 =

(

( )
( )
( )
( )
( ssrce )
( ssrce )
(tenpregq)
( node )
( )
( #rcve )
(dwnl oad)
(nodeptr)
( pntr3)
(statptr)

1,

net wor k

sl ave
sl ave
sl ave
sl ave

net wor k
# of

# of
down-
node

comm

comm

| oop
dest
dest
source
source
tenp
node
wor ds
wor ds
| oad
buf f er
buf f er
st at us

/* initiate commstate */

state
done
(i)
addr ess
addr ess
addr ess
addr ess
registr
numnber
to xmt
to rcve
node
poi nt er
poi nt er
poi nt er
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R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 7 - High-leve
** network conm state **
This block perforns the comunications with the nth node, xnmitting

the previously | oaded sfuncl3 buffer and storing the data read from
the node at the node rcve buffer

O:if (F3 == 1) /* commstate */

1 {

2 w4 = 0; /[* conmwith nth node */

3 B38 = sfunc13(896 B97, *W4, *W66, B98, *\Ws8, *\\4) ;

4. if (B38 == 2) /* conn1done9 */

5: {

6: W2 = (B96*512) +3d0O0H;, /* point to nth node rcve buffer */
7 VW4 = 7eOaH, /* point to sfuncl3 buffer */

8 while (B98 != 0) /* copy data rcved to node buffer */
9:

10: sfunc07(V@4, B87) ;

11: sfunc08( V82, B87) ;

12: ++W02, ++\W\4;

13: sfunc07(V@4, B87) ;

14: sfunc08( V82, B87) ;

15: ++W02, ++\W\4;

16: - - B98;

17: }

18: }

19: if (B38 >= 2) /* comm not busy? */

20: {

21: W4 = ((B96-1)<<l) + 1b0O0OH; /* save error code */

22: sfunc08( V@4, B38) ; ++\W\4;

23: sfunc08( V84, 0) ;

24 if (B38 !=2) /* commerror? */

25: B40 = B38; /* save error code */

26: WL06 = 1bOOH + ((B96-1)<<1); [* save commreturn value in */
27: sfunc07(WL06, B108) ; /* test for TI _READWRITE error */
28: if (B108 < 11H)

29: {

30: sfunc08(WL06, B38) ; ++WL06; /* TI-505 stat stack */
31: sf unc08(WL06, 0) ;

32:

33: F3 = 0; /* exit commstate */

34: }

35: }

36:

FO03 (netcom) network comm state
B038 (sfl13ret) sfuncl3 return val ue
B040 (commerr) comm error code

B087 (tenpregq) tenp registr
B096 ( node ) network node nunber
B097 ( #xmt ) # of words to xmt
B098 ( #rcve ) # of words to rcve
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bl ock: 7 - High-leve

B108
W66
W68
W92
W94
WLO06

(const at)
( sdest )
( ssrce)
(nodeptr)
( pntr3)
(statptr)

sl ave
sl ave
node

comm

comm
dest

source
buf f er
buf f er
st at us

st at us
addr ess
addr ess
poi nt er
poi nt er
poi nt er
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R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 8 - High-leve

0:/* test for downl oad node and wait until conplete */
1.if (F6 == 1)

2 {

3 if (BLO5 == 0) /* not in downl oad npde? */

4. {

5: FO = 1; /* start next commcycle with TI */
6: F6 = 0;

7 }

8

9 /* reset TI_WRI TE_ERROR */

10: W06 = 1bOOH + ((B61-1)<<1):
11: sfunc07(WL06, B108) ;

12: if (B108 == 12H)

13: sf unc08( W06, 2);

14: }

15:

16:if (B105 != 0) /* downl oad node? */
17:

{
18: sfunc07(1900H,B90); /* restore Tl-505 conm status stack address */
19: sfunc07(1901H, B91) ;

20: }

21:

22:sfunc08(1ff4H, 1); /* set node address to 1 (naster) */
23:

FOOO0 (select ) sel ect sl ave state
FO06 (condone) Tl 545 comm done

BO61 ( slave ) network slave nunber
B090 (Verrstk) Vmem error st ack
B091 (Verrstk) Vmem error st ack
B105 (dwnl oad) down- | oad node

B108 (constat) conm status
WL06 (statptr) comm status pointer
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R I R I O R I O I I I O R I I R I I I R R I I R R R O

bl ock: 9 - Assenbly

j nb F11, com enb ; power up TD conpl ete?

ib F10, com enb ; TI505 reset conplete?

anl h' c0, #h' fb ; reset Tl bus conplete latch

or | h' cO, #h' 4

j nb P3. 3, com enb ; TI505 still reseting?

clr | T1 ; level trigger on Tl bus intrpt
setb EX1 ; enabl e TI505 bus intrpt

setb F10 ; TI505 reset conplete

nov B105, #d' O ; enabl e task code an network comm
setb FO000 ; enabl e task code comm

=
QLN ARWNREO

11:E0n1enm

e
wn

FOO0 (select ) sel ect sl ave state
B105 (dwnl oad) down- | oad node
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R I R I O R I I R I I O I I I R I I I R I S R R R O O

bl ock: 10 - Ladder

Power
Up
Ti mer TD
o + FO11
0: +--| T E SR E SR E SR E SR E SR +-()--
| P:#00015] Pw UpTD
| TB:1.00
| A Bl10
| (Pwr UpTD) |
| Power |
| Up |
1: | TD |
oo +
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MCOM505 PROGRAM PRINTOUT

Typical Cross reference fornmat for variabl e:

file:block-1ine(usage)

where: file = file where variable is referenced.
bl ock = bl ock nunber in file.
line = line nunber in block
usage = sense that variable is referenced.

file key: IN initialization file.

MNF = nmain programfile.
TVMD = Timed interrupt file.
COM = co-cpu cominterrupt file.
Uxx = User function file (xx = ufunc nunj.
Usage key: * = variable value altered at referenced | ocation
(output coil, timer accumul ator, set equal, etc.)
+ = variable used in Assenbly bl ock

(usage in Assenbly bl ock unknown)

@= variable used as pointer in Hi gh-
I evel bl ock.

if *, 4+, or @is not associated with vari abl e,

the variable is not altered at |ocation
(contact, timer preset , tested for value, etc.)

Addr (ni cnane) description | ocation used

FOOO0 (select ) sel ect sl ave state MNF: 1-0 1-45* 3-13* 5-13*
MNF: 8- 5% 9- 9+

FOO1 (read TI) read Tl 545 state MNF: 1-42* 2-0 3-0 3-13*

FO02 (rd init) read state initiat MF: 2-2 2-11* 3-13* 3-51*
FO03 (netcom) network comm state MNF: 6-0 6-46* 7-0 7-33*

FO04 (witeTl) wite T1 545 state IWNF: 1-39* 3-51* 4-0 5-0
IMNF: 5-13* 5-53*

FOO5 (wr init) wite state initiat MF: 4-2 4-19* 5-13* 5-53*

FO06 (condone) Tl 545 comm done MNF: 5-53* 8-1 8- 6*

FO08 ( done ) done WMNF: 1-2* 1-3 1-26* 1-30
WNF: 6-2* 6-3 6-11* 6-21
FO09 (Tl done) Tl 545 t ask done MNF: 3-19 3-27* 3-38*
FO10 (Tlreset) TI 505 reset conp INI: 1-5*
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B038

B039

B040

B042

B043

BO56
BO57
BO58
BO59
B061

B062

B063

B064
B065
B066

( ni cnane)

( Pwr UpTD)
(tskfail)

(Tl conm )
(nunbl ks)
(sf13ret)
(err cnt)

(commerr)

¢ @) )

(#words )

(tskcode)
(#xmitt )
( #rcve )
(TIVai t )

)

( slave
( #send )
( #rcve )

( Vsrce )
( Vsrce )

( sdest )

APPENDIX A
MCOMS505 PROGRAM PRINTOUT

description | ocation used
Power Up TD MNF: 10- 0*
TI 545  task fail WNF: 3-4 3-17* 5-4 5-17*

Tl 545 t ask in prog MF. 3-2 3-16* 3-37* 5-2
M\F: 5-16* 5-33* 5-50*

# of bl ocks TI task MF: 2-7* 2- 9% 3-29 3- 36*
MNF: 4-16* 5-19 5-26*

sfuncl3 return val ue MNF: 7- 3* 7-4 7-19 7-22
MNF: 7-24 7-25 7-30

Tl task retry count MNF: 2-12* 3-6* 3-7 4-20*
M\F: 5-6* 5-7

comm error code MNF: 3- 9~ 3-11 5- 9~ 5-11
MNF: 7-25*
| oop (1) MNF:  1-3* 1-3 1-6 1-8
MNF: 1-25 1-3* 3-21* 3-21
MNF: 3-21* 4-5* 4-5 4-5*
MNF: 5-28* 5-28 5-28* 5-42*
MNF: 5-42 5-42* 6-3* 6-3
MNF: 6-6 6-8 6-10 6-15
MNF:  6-3* 6-36* 6-36 6- 36*
# of words renmain MNF: 4-17* 5-35 5-38 5-42

T1 545 t ask code MNF: 3-31* 5-21* 5-37*
t ask code  #xmtt MNF: 3-32* 5-22* 5-38*
t ask code #rcve MNF: 3-33* 5-23* 5-39*
TI Task Code Wai t IN: 1-7*

network sl ave number MF: 1-3 1-25* 1-32* 3-10
MNF: 3-52 4-23 5-10 8-10

# of words to send WMNF: 1-11* 2-6 2-7 2-9
MNF: 3-43 3-49*

# of words to rcve WMNF: 1-17* 1-33* 4-5 4-16
MNF: 4-17

Vmem source address MNF: 1-13*
Vmem source address MNF: 1-14*

sl ave dest address M\F: 1-15* 6-28*
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Addr (ni cnane) description | ocation used

sdest ) sl ave dest address MNF: 1-16* 6-29*

(

B068 ( ssrce ) slave source address MNF: 1-19* 6-32*

B069 ( ssrce ) slave source address MNF: 1-20* 6-33*

BO70 ( Vdest ) Vmem dest address MNF: 1-21*

BO71 ( Vdest ) Vmem dest address MNF: 1-22*

B086 ( pntrl) t ask buffer pointer MF. 2-4* 3-23@ 3-23* 3-24@
MNF: 3-24* 3-26* 4-14* 5-27*
M\F: 5-30@ 5-30* 5-31@ 5-31*
M\NF: 5-41* 5-44@ 5-45* b5-46@
MNF: 5-47*

B087 (tenpregq) tenp registr MF 1-7* 1-8 1-36* 1-38
MNF: 3-45* 3-46  3-47* 3-48
MNF: 4-7* 4-8 4-10* 4-11
MNF: 6-7* 6- 8 6-39* 6-40
M\F: 6-42* 6-43 7-10* 7-11
MNF: 7-13* 7-14

B087. 0(tregbt0) tenp reg bitO MNF: 1-37* 1-37

B090 (Verrstk) Vmem error stack INI: 1-0*
MNF: 8- 18*

B091 (Verrstk) Vmem error st ack INI: 1-1%
MNF: 8- 19*

B096 ( node ) network node nunber MNF: 6-3 6-10* 6-22* 7-3
MNF: 7-6 7-21  7-26

B097 ( #xmt ) # of words to xmit MNF: 6-26* 6-36 7-3
B098 ( #rcve ) # of words to rcve MNF: 6-30* 7-3 7-8 7-16*

B105 (dwnl oad) down- | oad node INI: 1-4*
MNF: 6-0 8-3 8-16  9-8+

B108 (constat) conm status WNF: 4-24* 4-25 7-27* 7-28
M\F: 8-11* 8-12

B110 (Pw UpTD)  Power Up D MNF: 10- 0*

B152 ( xbuff ) tskcode wite buffer MF: 4-14 5-27 5-41

B182 ( rbuff ) tskcode read buf f er WNF: 2-4 3-26

W36 ( Vaddr ) Tl 545 Vmem address MNF: 2-10* 3-34 3-35* 3-35
MNF: 5-40
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Addr (ni cnane) description | ocation used

W64 ( Vsrce ) Vmem source address MNF: 2-10
W66 ( sdest ) sl ave dest address M\F:. 7-3@
W68 ( ssrce ) slave source address MF:. 7-3@
W70 ( Vdest ) Vmem dest address MN\F: 1-34* 4-18

W84 (slveptr) sl ave buf fer pointer MF: 1-6* 1-7 1-10* 1-10
MNF: 1-11 1-12* 1-12 1-13
MNF: 1-13* 1-14  1-14* 1-15
MNF: 1-15* 1-16 1-16* 1-17
MNF: 1-17* 1-18* 1-19 1-19*
MNF: 1-20 1-20* 1-21 1-21*
MNF: 1-22 1-24* 1-24  1-35*
MNF: 3-46  3-46* 3-48  3-48*
MNF: 3-52* 4-7 4- 9% 4-10

W88 ( pntr2 ) network buffer pointer MNF: 2-5* 3-23 3-23* 3-24
MNF: 3-24* 3-42* 3-45  3-46*
MNF: 3-47  3-48* 4-4* 4-8
MNF:  4- 9% 4-11  4-12* 4-15*
M\F: 5-30 5-30* 5-31  5-31*
MNF: 5-44  5-45* 5-46  5-47*
W90 (Verrstk) Vmem error stack WMNF: 1-34

W92 (nodeptr) node buffer pointer WMF. 6-6* 6-7 6-25* 6-25
M\F: 6-26  6-27* 6-27 6-28

MVF: 6-31* 6-31 6-32  6-32*

MNF: 7-11  7-12* 7-14  7-15*
W94 ( pntr3) buffer pointer WMF. 6-35* 6-40 6-41* 6-43

WL06 (statptr) conmm status pointer MF 3-10* 3-11 3-11* 3-12

MF: 7-27 7-30 7-30* 7-31
MNE: 8-10% 8-11  8-13

WL50 (Vstack ) Vmem read st ack MNF: 3-34* 5-24* 5-40*
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(This Page Intentionally Left Blank)
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APPENDIX B

RS-232/RS-422 PIN OUTS/ CABLES

1: NOT USED
2: RXD (RECEIVE DATA — IN)
6 1 3: TXD (TRANSMIT DATA —OUT)
5 2 4: NOT USED
8 3 5: SG (SIGNAL GROUND)
9 4 6: NOT USED
5 7: NOT USED
8: NOT USED
9: NOT USED
PROG Port Pin Out
1: NOT USED
2: RS—232 RXD (RECEIVE DATA — IN)
6 1 3: RS—232 TXD (TRANSMIT DATA —QUT)
7 2 4: NOT USED
8 3 5: SG (SIGNAL GROUND)
9 4 6: RS—422 TXD+ gTRANSMIT DATA — OUTg
5 7: RS—422 TXD— (TRANSMIT DATA — OUT
8: RS—422 RXD+ (RECEIVE DATA — IN
9: RS—422 RXD- (RECEIVE DATA — IN
USER Port Pin Out
DB9 FEMALE DB9 FEMALE
COMPUTER INTERFACE PROG PORT
N\
RXD] 2 % 2 RXDjI
TXD] 3 3 [TXD
[SG] 5 5 [SG]
RTS] 7
crs] 8 |
DSR] 6
pTR] 4
DB9 (com1l) to PROG Port Cable
DB25 MALE DB9 FEMALE
COMPUTER INTERFACE PROG PORT
N\
TXD] 2 2 [RXD
RXD] 3 3 [TXD
[SG] 7 5 [SG]
RTS] 4
crs] 5
DSR] 6
DTR] 20 |
DB25 (coml) to PROG Port Cable
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